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Introduction 
 

This training manual is intended for Transportation Engineers, Engineer Assistants, Transportation 
Specialists, and Design Technicians that are planning to create 3D models of existing and future bridges 
using OpenBridge Modeler (OBM). 

OpenBridge Modeler is not a design tool, it is only a modeling application. This manual will not go into the 
details of the design and analysis applications included in OpenBridge Designer (OBD). 

The training is broken into sections: 

• Interfaces – Covers the OBD and OBM Interfaces 

• Create Bridges one element at a time. – Covers the steps to place the different bridge elements. 

• Create Bridges using the Bridge Wizard – Covers the instructions on how to use the wizard and 

finish the bridge after placement.  

• Place Excavation – Demonstrates the excavation tools. 

• Place Riprap – Demonstrates the linear templates tools in OBM. 

• Generate Reports – Covers the different reports included in OBM. 

• Create and Modify Bridge Templates – Shows how to modify and create templates. 

• Plan Production – Shows how to use the plan production tools in OBM. 

• Interoperability – Shows how to transfer to the design and analysis applications included in OBD. 
 

For questions about the content included in this manual please contact bridge3ddesign@txdot.gov. 
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Interfaces of OpenBridge Designer and OpenBridge Modeler 

In this section the user will review the OpenBridge Designer and OpenBridge Modeler interface. 

OpenBridge Designer Interface 
If OpenBridge Designer is not used, please skip to page 7 or the next section to learn about the OpenBridge 
Modeler interface. 

• Open OpenBridge Designer from the Desktop shortcut or the Start menu. 
• The welcome page: In this page the user will have three options. Open a file, create a file, and login 

to ProjectWise (the user must first log-in to ProjectWise, if the files to be opened or created, are 

stored in ProjectWise) 

 
• Login to ProjectWise using the ProjectWise button. Make sure to NOT enable the auto-login option as 

this will cause possible inconveniences in the future. The datasource used for trainings is Training 

and the Authentication is always set to Bentley IMS. 
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• Once logged in, press the Browse button, and navigate to Documents\25 - CHS\Design 

Projects\XX-BRG300\4 - Design\Bridge\ and open the OBD Interface.obdx file. 

Note: The XX in the project name will be replaced by the user’s first and last name. 

 
 

o BIM Workflow: This workflow is used when the user wants to strictly manage all models 

using OpenBridge Modeler. In this workflow the user is not allowed to add LEAP or RM files.  
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o Standalone: This workflow is used when the user wants to create OpenBridge Modeler files. 

From OBM the models can be exported to LEAP or RM Bridge. The models can then be 

analyzed and designed. Model changes done in LEAP or RM will not be pushed back to OBM. 

In this workflow the user can select the Analysis group to add LEAP or RM files without 

having an OBM file first. 

 
o Drawings: The Drawings button is only available in the BIM workflow. This button provides 

previews of drawings generated using the plan production tools in OBM. OBD will list all 

sheets created within the same OBM file when the Drawings button is pressed. For 

modifications to the sheets, the user needs to launch OBM and make the necessary 

modifications there. Please note that the TxDOT workflow separates the OBM File from the 

drawing and sheet files and this button may not be used. 

 

o At the lower right-hand section of the OBD dialog box the user can find the ProjectWise Log-

in status. 
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OpenBridge Modeler Welcome Interface 

When the user opens OpenBridge Modeler from the OBD interface the user will first see the Welcome 

page. 

• Open OpenBridge Modeler either by pressing the OpenBridge Modeler button in OBD or by 

double clicking the OpenBridge Modeler icon in the desktop or start menu. 

 

 
 

• When prompted, login to ProjectWise, the datasource used for trainings is Training and the 

Authentication is always set to Bentley IMS. 

 
o Left Side Section: In this side of the welcome page, OBM will list the recently used 

WorkSets. The name of the WorkSpace assigned to the WorkSet is listed above the WorkSet 

name. 

Note: The history will not be populated when working in ProjectWise. 
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o Right Side Section: In this side of the welcome page, OBM will report the properties of the 

selected WorkSet. 

Note: The ProjectWise properties here refer to the ProjectWise 365 project, which is not the 

same as the ProjectWise Explorer application that is used in TxDOT. 

 
o Middle Section: In this area of the welcome page, OBM will keep track of the previously 

opened files within the WorkSpace and WorkSet selected. In this section the user can also 

open existing files using the Browse button or create new files using the New File button. 

Note: The file will appear if the user remains in the same OBM session and while the 

WorkSet is not changed. This may be lost if the WorkSet is changed, and the user will simply 

have to use the Browse button to open existing files. 
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OpenBridge Modeler User Interface 

The OpenBridge Modeler interface is shared by MicroStation CONNECT Edition, ProStructures CONNECT 

Edition, and OpenRoads CONNECT Edition. The interface is now a ribbon-based interface leaving behind the 

Toolbox interface; however, toolboxes are still accessible for use. 

The Ribbon is categorized by Tasks. This guide we will go over the OpenBridge Modeler task interface. 

• Continuing from the previous section, press the Browse button and navigate to Documents\25 - 

CHS\Design Projects\XX-BRG300\4 - Design\Bridge\Bridge X\  and open the OBM 

Interface.dgn. Accept the workspace reload when prompted and let the file load. 

o The File Tab or Backstage View: In this tab the user can access the “New”, “Open”, “Save”, 

“Save As”, “Save Settings”, “Print”, “Export”, “Import”, etc. The user can also find tools such 

as “Batch Convert”, “Batch Process”, “Packager”, and “Compress File”, etc. Finally, the user 

may also find “User Settings”, “File Settings”, and “Configuration Settings”. 

           
o The Home Tab: In this tab the user will find all the tools to perform the activities of the Task 

selected. For this training manual we are focusing in the OpenBridge Modeler task, so the 

tools available in the Home tab are the tools to create and modify bridge models. The ribbon 

is separated by sections as follows: 

 Primary: This section contains the Reference, Raster, and Point Cloud attachments; 

Level Display and Level manager; Models; Key-In, Accu-draw, and Cells tools; 

Element Properties; and Explorer tool. 

 
Note: Usually the icons will be small, but for this example the size was set to large. 
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 Selection: This section will contain the Cut, Copy and Paste which work with the 

clipboard. The section also contains the Select all, Select None, Select by Attributes, 

Place Fence and Fence manipulation tools, and Element lock and unlock tools. 

 
Note: Usually the icons will be small, but for this example the size was set to large. 

 

 Bridge Setup: This section has all the tools to setup a new bridge such as import 

geometry, add new bridge, add new unit, set the bridge alignment, set the bridge 

terrain, move bridge, and the add multi-unit bridge. In addition, the Bridge Wizard is 

also located in this section. 

 
 Support Line: This section has all the tools for the placement and manipulation of 

support lines. 

 
 Superstructure: This section has all the tools to place the superstructure of the 

bridge. Different tools become available when specific types of bridges are being 

modeled. 

 
 Substructure: This section has all the tools to place substructure elements including 

excavation around footings, bearing pads and seats on abutment caps and interior 

bents. 
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 Accessory: This section contains all the tools to place ancillary structures such as 

traffic barriers, 3D cells for luminaries, overhead structures, and signs. 

 
 Approach Slab: This section has the tools to place approach slabs and sleeper slabs. 

These tools require additional templates for the sleeper slabs. 

 
o The Civil Tab: In this tab the user will find all Civil tools needed to create a bridge geometry. 

However, it should be mentioned that all civil geometry should be created using ORD, this 

tab is strictly used to open dynamic views such as Cross Section or Profile views, and to 

open optional geometry reports such as Horizontal and Vertical reports, and Cross Section 

reports. The ribbon is separated by sections as follows: 

 General Tools: This section contains the tools to import and export geometry, apply 

and remove feature definitions to civil geometry, and the reporting and analysis 

tools. 

 
 Horizontal: This section has all the horizontal geometry tools. These tools are the 

same found in ORD. However, the number of tools is limited to what is needed to 

create a bridge. Additionally, these tools can be used to create riprap elements 

around abutments. 

 
 Vertical: This section has all the vertical geometry tools. These tools are the same 

found in ORD. However, the number of tools is limited to what is needed to create a 

bridge. Additionally, these tools can be used to create riprap elements around 

abutments. 
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 Superelevation: This section has all the superelevation tools. These tools are the 

same found in ORD. However, the number of tools is limited to what is needed to 

create a bridge.  

 
 Cross-Sections: The only tool available in this section is the Dynamic Cross Section 

viewer. This tool works the same as it does in ORD. 

  
 Terrain Model: This section has all the terrain tools. These tools are the same found 

in ORD. However, the number of tools is limited to what is needed to create a 

bridge. Additionally, these tools can be used to create riprap elements around 

abutments. 

 
 3D Geometry & Template: These sections have the tools that can be used to create 

riprap elements around abutments when used along the horizontal, vertical, and 

terrain tools. These tools are the same found in ORD. 

 
o The Utilities Tab: In this tab the user will find the interoperability tools which are used to 

transfer data to the analysis and detailing applications. Here the user will also find the 

import/export tools, templates tools, item types tools, and more. The ribbon is separated by 

sections as follows: 

 Interoperability: This section has the tools to export and read-in the bridge 

information to and from LEAP and RM Bridge applications. 

  
 Import/Export: This section has the tool to export and import superstructure and 

substructure templates, and to export the terrain model to different formats. 
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 Libraries: This section contains all the different template libraries used by OBM, in 

this section the user will create the different Deck, Beams, Barriers, Interior Bents, 

Abutments, and more templates used to create a bridge. 

 
 Parametric Cell: This section contains the tools to map variables of parametric cells 

to select OBM variables and to tag certain elements of parametric cells as structural 

elements. 

 
 Generative Component (GC): This section contains the tools for variable mapping for 

all generative components in OBM. 

 
 Accu-draw & ACS: These sections have the Accu-draw toggle and the auxiliary 

coordinate system tools, these tools are the same as found in the Drawing task and 

in MicroStation. 

 
 Item Types & Reports: These sections have the item types that can be attached to 

elements of the OBM Model and the report tools to create reports used in the item 

types. 
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o The Reports and Drawings Tab: In this tab the user can find the plan production tools, 

reporting tools and other MicroStation tools such as measure, place line, and drawing scales. 

The ribbon is separated by sections as follows: 

 Bridge Reporting: This section has the tools needed to create different types of 

reports for different structural elements of the bridge(s), in addition the user can 

create quantities report and input reports. 

 
 Drawings & Labels: These sections contain all the tools to create drawings. Part of 

the tools are specific to OBM but the other tools are the same found in the plan 

production tools of ORD and MicroStation. 

 
 Drawing Scale, Measure, and Placement: These sections have the same tools found 

in the Drawing task in OBM, ORD, and MicroStation. These tools can be used to 

change the annotation scale, place 2D/3D elements, and measure elements. 

 
o The View Tab: This tab is common in all applications and tasks, and it has the same tools on 

all applications used in TxDOT. The user can find view manipulation tools, saved views, view 

clipping tools, and view navigation tools. 

 

 
o The Collaborate Tab: This tab contains tools to connect the project with an iTwins project, to 

check the integrity of the model with clash detection and to markup or annotate the model 

during reviews. 
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o TxDOT Custom Tools Tabs: These tabs will contain specific tools targeted only for TxDOT 

use. These tabs will only be found in the Drawing task because this task is common on all 

applications. Some of these tabs include Axiom, WinCore and possibly custom tools. 

 
o Axiom Tab: To import Excel, Word, and Powerpoint data into 2D drawings only. 

 
o WinCore Tab: To be used in 2D drawings only. 

 

For additional information on the individual tools consult the OpenBridge Modeler help documents here: 

OpenBridge Modeler Help (bentley.com) 

 

 

 

 

 

 

 

 

 

 

 

 



 

 OpenBridge Designer/Modeler Training Manual | 16 

Creating Bridge Models – One element at a time. 
Now that we are familiar with the OpenBridge Interface we will proceed to create a new Bridge Model 
without using the Bridge Wizard. This section will use a workflow that strictly saves the files in ProjectWise 
and the local environment will not be used. In this section we will be creating one Precast Model and one 
Steel Model to review all the tools. 

Note: This section will not guide the user on how to create terrain files and 3D alignment geometry for the 

bridges. The assumption is made that these files have been previously created by the Roadway group. To 

learn how to create these files and more using ORD please enroll to the DES750: OpenRoads Designer for 

Plan Development training in Peoplesoft. 

Create a New OpenBridge Designer File 
If OpenBridge Designer is not getting used, please skip to page 20 or next section to start with OpenBridge 
Modeler. 

• Close all sessions of OBM and then close and re-open OpenBridge Designer. 

 
 

• Login to ProjectWise using the ProjectWise button. Make sure to NOT enable the auto-login option as 

this will cause possible inconveniences in the future. The datasource used for trainings is Training 

and the Authentication is always set to Bentley IMS. 
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• Once logged in, press the New File button, and save the new OBDX file called TxDOT OBM 

Training.obdx in the Bridge folder of the ProjectWise Training Work Area assigned to the user. 

 
• Once the file is saved, select the Standalone Workflow. 

 
• Select the Add Standalone Group icon. 

 
 

  



 

 OpenBridge Designer/Modeler Training Manual | 18 

• Use a name that describes the type of work that is going to be stored in the group. For this training 

use Precast Bridge Training. 

 
•  Click the OpenBridge Modeler Button to run the application. 
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Create a New OpenBridge Modeler File 

When working in ProjectWise the workspace and workset is setup automatically, the section can be ignored, 

and the user can proceed to create a new OBM file or to open an OBM file. For this training we will ignore 

the workspace and workset and use the new file button because the training is stored in ProjectWise. 

1. If OBM is open, close and re-open OpenBridge Modeler either by pressing the OpenBridge 

Modeler button in OBD or by double clicking the OpenBridge Modeler icon in the desktop or start 

menu. 

 

 
 

2. When prompted, login to ProjectWise, the datasource used for trainings is Training and the 

Authentication is always set to Bentley IMS. 

 
 

3. Once OBM is loaded, ignore the WorkSpace and the WorkSet area. Press the New File to create a 

new OBM file. 
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4. During the file creation verify that the TxDOT_BridgeSeed3d.dgn seed file is selected and save the 

file to the correct path as shown below.  

• File creation method: No Wizard 

• Browse to Documents\25 - CHS\Design Projects\XX-BRG300\4 - 

Design\Bridge\Bridge X\ 

• Verify that the Seed is 

Documents\_Resources\ClientWorkspaces\TxDOT\TxDOTConnect10.12\Organizat

ion-Civil\TXDOT\_Bridge\OpenBridge Modeler\Seed\TxDOT_BridgeSeed3d.dgn 

• Key-in the new file name Bridge_Model_01.dgn. 

• Set the application to OpenBridge Modeler 

• When prompted accept the reload of the workspace. 
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Create a Bridge with Concrete Superstructure 

1. Once the file is created, proceed to attach the geometry files and terrain file as references. These 

files will be used in the creation of the new bridge. 

Note: Only the horizontal and vertical alignments are required to create a bridge, but this training 

will also utilize terrain files to refine substructure footings, excavation geometries, and rip rap. 

• Attach horizontal and vertical alignments:  

3D Corridor Modeling\Geometry\US281_GEOM.dgn 

Note: As instructed by DES750, the terrain should be attached to the geometry file and made 

active there for the strip elevations to work, there is no need to attach the terrain as 

separate file. 

• Optional Attachment Edge of Pavements: 3D Corridor Modeling\Geometry\US281_EOP.dgn 

• Optional Attachment Superelevation shapes: 3D Corridor 

Modeling\Geometry\US281_SUP.dgn 

• Attachment Options: 

o Model Name: Default 

o Orientation: Coincident – World 

o Detail Scale: Full Scale 1:1 

o Live Nesting: 2 
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2. Once all files have been attached, press the Fit View   icon to fit the view around all 

attachments. Also, click File > Save Settings to automatically see the project extents when 

opening the file. 

 
3. We need to set the GeoCoordinate system of the OBM file to match the GeoCoordinate definition of 

the reference files. To do so use the Search Ribbon. 

• Key in: Coordinate 

• Select from the results: Coordinate System 

• In the dialog use the From File icon 

• Navigate to 3D Corridor Modeling\Geometry\US281_GEOM.dgn 

• Select the appropriate Coordinate Systems and press OK. 

• Once the correct Coordinate System is selected (shown below) close the window. 
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4. This dataset is used for other trainings in TxDOT, for this OBM training we will be focusing on the 

US281 Southbound and Northbound Main Lanes Overpass bridge. 

  
5. Enable the Terrain contours. 

• Select the green boundary of the terrain. 

• Open the properties dialog box. 

 
Note: The properties dialog box is used constantly in this training, it is recommended to dock the 

dialog box around the working area. This is done by clicking and dragging the Properties dialog, then 

choosing which side of the screen to dock to. This is shown below. 
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• In the properties dialog box, locate the Reference section. 

 

 
 

• In the Reference section, change the Override Symbology to Yes and the Override 

Template to Terrain\Existing Contours. 
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6. Create the Bridge placeholder by selecting the Add Bridge button. 

 
• Description: US281 Southbound Mainlane 

• Structure Number: 15-046-0-0253-03-052   [This is the NBI Number] 

• Requires Road Alignment: False 

• Use Road Alignment For Stationing: False 

• Unit Name: Unit 1 

• Unit Description: 215.00’ Prestr. Conc. I-Beam Unit (45’-125’-45’) 

• Unit Bridge Type: Beam Slab (P/S or RC Concrete Girders) 

• Feature Definition: Bridge_decorations 

• Name Prefix: US281_SBML 

• Select the alignment for the US281 SBML, then accept by pressing the left mouse button 

anywhere in the screen. 
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• After the bridge placeholder is created, verify it appears in the project explorer. The user 

can review the entered information by selecting the bridge or the unit in the explorer, the 

information will appear in the properties dialog box. 

 

 

Note: To rename the bridge or unit, the user needs to right-click the element from the explorer 

and select Rename. Other information can be changed in the properties dialog box while the 

element is selected. When more than one unit or bridge exist in the file the user needs to make 

that unit or bridge active to make changes. Bridges and units can be made active by right 

clicking on the unit or bridge and selecting Make Active. 

7. Set the terrain as active terrain for the bridge using the Terrain button. 

 
• Click on any part of the terrain boundary of the file to accept. Once the terrain has been 

made active it will also appear under the bridge name in the project explorer. 

 
Note: If the terrain name does not appear, close and reopen the explorer to refresh the 

contents. 

• Additionally, set the terrain active to the civil features using the available civil tools in OBM. 

Select the terrain boundary to accept. 
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8. Next, we need to add the SupportLlines. SupportLines define the locations of the start/end of the 

bridge and the substructure abutments/bents. Return to the Home tab, press the down arrow next 

to the Place button in the SupportLine section and select the Multi tool. 

       
• Skew Angle: -10º00’00” 

• Length: 70 [this is for the support line] 

• Start Station: 14+18.00 

• End Station: 16+33.00 

• Number of SupportLines: 4 

• This will require 3 clicks, 1 for start station, 1 for skew, and 1 for end station.  

 

In the Place Multi SupportLines dialog 

• Change the support line names to reflect the type of support (e.g. Abutment #, Bent #) 

• Change the span lengths as shown in the image below 

• Span 1: 45’ 

• Span 2: 125’ 

• Span 3: 45’ 
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• Press OK once all changes are completed. Press the right button of the mouse to end the 

place multi support line tool. 
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Knowledge Tip: If the support lines need to be modified, press the Modify button of 

the SupportLine section of the ribbon. 

 

Knowledge Tip: If the user needs to insert a span, this can be done by adding a 

support line in between the existing supports lines using the Place > Middle Point 

tool from the SupportLine section of the ribbon. 

 

Knowledge Tip: A bridge can also be created with the Add Multi-Units button, this 

will allow the user to place a new bridge and define multiple types of units and spans. 

This tool merges the Add Bridge and Place Support lines into one. 

 
• User needs to provide Bridge Description, Bridge Name Prefix, Start Station* 

• User needs to know the span lengths, beam types, skew angles. 

 

*The station input does not work. The user will have to eyeball the start station then use the 

Move SupportLine tool to move the bridge to the correct station. 
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9. Once the SupportLines have been placed, the next step is to place the deck. 

Note: If multiple units exist in the bridge, the placement of any bridge element can only be 

performed on the active unit. The active unit appears with a green icon  in the project 

explorer. 

• Press the Place Deck button in the Superstructure section. 

 
• In the Place Deck dialog box. 

o Template Name: Standard Templates\TxDOT Decks\Bridge Deck [ ] 

o Add Constraints: True 

o Analytical Deck: True 

o Deck Material: Tx Deck [ ] 

o Deck Breakbacks: 0 [zero] 

o Name Prefix: MainDeck-Unit1 

Note: Deck breakbacks are only needed for skews greater than 15º and usually the 

start and end values are set to 2.000. 

• Select the first and last SupportLines, a single click per support line. Be sure that the 

support line gets highlighted. Click one more time to accept and the Variable Constraints 

window will open. 
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• Four columns are shown on the left side of the dialog: variable name, active, default, and 

errors.  

 
• The default column shows the values that were used to create the template, these fields 

cannot be changed.  

• To modify the template, select the variable name, then toggle the active check mark. The 

right side of the dialog will show a table. 

 

• To add rows to the table the user needs to press the green plus sign . 

• Use the information below to define the following variation constraints. 

o LT_Width_Lane1: -23  [Start to End] 

o RT_Slope_Lane1: +2%  [0.02][Start to End] 

o RT_Width_Lane1: +19  [Start to End] 

 
 

 
 

 
 

 
Click OK to apply the changes and close the Variable Constraints window. 
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Knowledge Tip: In addition to SupportLine, the variations to the deck can also be 

applied by ratio and by station. 

 
• SupportLine Mode uses the SupportLine selected in the From field as the start limit, if a 

value is provided where the zero is, the variation will start that far from the support 

selected. For example, the image below shows variable starting 30’ from the Abutment1. 

 
• Ratio by Span Mode uses a specific span selected as the overall span length and the 

value provided is a ratio of the total span. For example, the image below shows a variable 

applied to 15’ of Span 1 [15’/45’=0.33333]. 

 
Note: This option is not recommended to be used for decks, this is usually used in 

Beams and Cross frames. 

• Station Mode uses a station to determine where a section of the variation will start. 

 
Note: Any portion of the deck before the starting station will be using the default values. 

• The start and end values are the values that the user needs to provide. For example, the 

image below shows a slope transitioning from -2% to +2% only in Span 2 (Bent2 – 

Bent3). 
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Note: If a row was added by mistake, simply select the row (highlighted in blue) and press 

the Delete Selected . If the deck variables need to be modified, select the 

deck and in the properties press the SELECT to Edit button [ ] next to the Variable 

Constraint field. 
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 Knowledge Tip: The cross slopes and deck width can also be applied by using the 

ORD elements such as edge of pavement lines and superelevation shapes when 

available. 

• To apply the cross slope using a superelevation shape, use the Assign Superelevation 
tool.  

 
• The user will click on the cyan boundary of the superelevation shapes, then reset to 

accept selection. Once the superelevation shape is selected, the user will need to click 

on the deck element to apply it and a superelevation table will appear, press OK to 

accept the changes. 

 
• If a warning appears, simply click yes to continue. 

 
• To apply the deck width using point controls, select the deck and in the properties, 

dialog locate the Deck section, in that section find the Point Control and press the 

button to edit [ ]. 

 
• In the point control dialog, the user can control the different points of the deck with 

elements created in ORD or using the civil tools in OBM. The points can be control 

horizontally, vertically, or both. To add a point control, select the direction from the 

drop-down menu, then click the Select button to identify the plan element in the 

screen. Once identified the plan element name will appear in the Path column. 

 
• When the user finishes making the selection press the Apply button to apply all 

changes and then press Close to close the dialog box. 
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10. After the deck is placed press the right-click button to end the deck placement tool, the next step is 

to place the beam layout. To do this press in the Beam Layout button, and then identify the limits 

of the deck using the SupportLines, like what was done in the step before. 

 
Input the following values into the Beam Layout window: 

• Span 1 [Abutment1 – Bent2] 

o Number of Beams: 6 

o Edge Distance: 3.000 

o Equal Edge Distance: True 

o Same Beam Start/End Values: False 

o Click Apply. 

o Beam Start - SL Offset(“): 3.000 

o Beam Start - Skew Ends: True 

o Beam End - SL Offset(“): -3.000 

o Beam End - Skew Ends: False 

• Span 2 [Bent2 - Bent3] 

o Number of Beams: 8 

o Edge Distance: 3.000 

o Equal Edge Distance: True 

o Same Beam Start/End Values: False 

o Click Apply. 

o Beam Start - SL Offset(“): 3.000 

o Beam Start - Skew Ends: False 

o Beam End - SL Offset(“): -3.000 

o Beam End - Skew Ends: False 

• Span 3  [Bent3 – Abutment4] 

o Number of Beams: 6 

o Edge Distance: 3.000 

o Equal Edge Distance: True 

o Same Beam Start/End Values: False 

o Click Apply. 

o Beam Start - SL Offset(“): 3.000 

o Beam Start - Skew Ends: False 

o Beam End - SL Offset(“): -3.000 

o Beam End - Skew Ends: True 
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• Once completed press Validate to verify the input and Save to save the beam layout. 
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Knowledge Tip: If different spans have the same beam layout, you can save time 

inputting your data with two methods: 

1. Define your data for one span, then set it as the Default Span using the drop down 

on the left of the Beam Layout window. Check on Set All To Default option to apply 

the default Beam Layout data to any other span with the Use Default option 

enabled. 

 
2. Define your data for one span, then select all with Ctrl+right click. Copy the data 

with Ctrl+C, select another span, then paste the data with Ctrl+V. 
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Note: If you add additional beams, select the data input box for any column and press Enter 

to apply that value to all of the rows. 

 

 
Note: If the beam layout needs to be modified, select the beam layout and in the properties 

press the SELECT to Edit button [ ] next to the Pattern field. 
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Knowledge Tip: For beams that require multiple bearing pads the user will need to 

define the multiple pads in the Beam Layout dialog box. 

 

• The user will need to provide the number of bearing pads required, and the spacing in 

between their center lines of the pads. 

 
The user can also match the beam report generated by BGS, the user can change the 

Method to Along Skew, and the Spacing Reference for the first and last beams 

will be set to Alignment. 

• BGS reports the location of the first beam in relation to the alignment along the CL of 

the bent, regardless of skew. The user can take this value and enter it as a negative if 

located to the left of the alignment looking upstation or positive if located to the right of 

the alignment looking upstation to the beam 1 spacing field. 

     
 

• The last beam spacing will be the TOTAL minus the distance to beam 1. (i.e. 32.000 – 

26.000 = 6.000) and this will be entered as a negative if located to the left of the 

alignment looking upstation or positive if located to the right of the alignment looking 

upstation. 

 
 

• For the rest of the beam spacings, the user can enter the spacings as reported by BGS. 

In OBM it only allows to enter the spacings of the interior beams, with respect to the 

previous beam, so the last spacing reported in BGS will be omitted. 
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11. Once the beam layout is placed the next step is to place the beams. Press the Place Beam button. 

 
• Custom: True 

• Use Beam Rotation: False [Only required for non-plumb beams] 

• Click on the beam layout created in the previous step, then one more left click is required to 

accept the selection. 

 
In the Beam Definition dialog box. 

• Beam Type: Custom 

• Haunch Start: 3.5” 

• Haunch End: 3.5” 

• Start Template: Beams\Standard Sections\TxDOT\Tx Girders\Tx54 

• Different End Template:  False 

• Material: Tx I-Girder 

• Apply To All Beams: True [Located at bottom left corner of dialog] 

• Press the OK button to accept the beam definition. 

 
Note: If the beams need to be modified or reviewed, select the beam group and in the 

properties press the SELECT to Edit button [ ] next to the Beam Definition field. 
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12. The next step is to place the substructure, we will start with the interior bents and then the 

abutments. To start press the Place Pier button of the Substructure section. 

 

• Template Name: MultiColumn\TxDOT\Interior Bent for TxGirder and Similar [ ] 

• Cap Length Adjustment: Deck and Aligned 

• Cap Material: Tx Interior Bent Cap [ ] 

• Column Material: Tx Column [ ] 

• Footing Material: Tx Drilled Shaft [ ] 

• Name Prefix: Bent2 

• Select the support line for the interior Bent #2 (be sure it gets highlighted), then reset 

(right-click) to accept selection. An additional left click is required to accept the elevation 

constraint selection as “No”. 
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• This bent does not require additional changes, but if the deck had a crown, we would change 

the bent cap to match the crown. 

• Repeat these steps for the Interior Bent #3, just change the name prefix to reflect the bent 

number. 

 
 

 

 

 

 

Knowledge Tip: Column lengths, drill shaft lengths, footing, ear walls, and footing piles 

are all controlled in the template’s variable constraints. To access the variable 

constraints, select the bent and open the Properties dialog, then select the SELECT to 

Edit [ ] of Substructure Template. The user can also control the column lengths by 

selecting the SELECT to Edit [ ] of Elevation Constraints, in this section the user 

can also change how the top slope of the cap is drawn: level, parallel to the deck, or 

crowned. 

One important thing to mention is that the column spacing is calculated from the nearest 

column when the Auto Spacing option is selected in the template, this works fine for 3 

columns, but for anything greater than 3 columns it is recommended to manually enter 

the spacings in inches. 
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13. The next step is to add the abutments, to start press on the Place Abutment button of the 

Substructure section. 

 
• Template Name: PileCap\TxDOT\Abut for TxGirders and similar with DS up to 15 

deg skew [ ] 

• Apply Skew To Solids: True 

• Conform BackWall With Deck Top: True 

• Edit Elevation Constraints: False 

• Orientation: Start 

• Cap Length Adjustment: Deck and Aligned 

• Cap Material: Tx Abutment [ ] 

• Pile Material: Tx Drilled Shaft [ ] 

• Name Prefix: Abutment1 

• Select the first support line (be sure it gets highlighted), then reset (right click) to accept 

selection. An additional left click is required to accept the elevation constraint selection as 

“No”. 

     
• Once the abutment is placed select the abutment, and in the properties press the SELECT 

to Edit [ ] in the Substructure Template field. 

o Back Wall Depth: 70” [Bearing Seat (1.25”) +Pad (2.75”) +Beam (54”) + 

Haunch (3.5”) +Deck (8.5”)] 

o Back Wall Vertical Offset: 70” 
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o In the Piles tab press the Pattern Layout and change the number of columns to 4, 

then press the Generate Piles, then press OK to accept the change. 

 
o Press OK again to accept all changes to the Abutment 1. 

• Back to the properties section, account for an approach slab atop the abutment backwall by 

changing the BackWall Vertical Offset From Deck Top to -..13 (13”) or -1.08333’. 

Note: [dot dot is a shortcut to the sub units in this case inches] 

 
Note: Similar as all previous bridge elements if things need to be changed the user can 

access all geometry and elevation constraints via the properties dialog box. 

 

Knowledge Tip: The drilled shaft spacings are calculated based on the abutment 

length, when the abutment is placed on a skew, it is recommended to enter the 

correct abutment length to see the drilled shaft spacings in the Pile Layout dialog 

box. In addition, when the tip elevations are different per drilled shaft the user 

needs to toggle the Manual checkmark to enter the pile length of the individual 

piles. The Longitudinal and Transverse angles are used when the piles are battered, 

and the angles can be changed from degrees to ratio by changing the Angle 

Display option. 
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14. Next, we will place the abutment 1 wingwalls using the Place Wingwall button from the 

Substructure section. 

 
• Place Left Wingwall: True 

• Template Name: Wingwall\TxDOT\Wingwall with Cap and DS [ ] 

• Orientation:  Normal/Skewed 

• Vertical Offset: ..70 [70” = 5.8333’] 

• Align with Abutment: False 

• Transverse Offset: 0.7500 

• Align with FFBW: True 

• Parallel to Alignment: True 

• Use Slope from Profile: False 

• Place Right Wingwall: True   

• Vertical Offset: ..78.5 [ 78.5” = 6.5417’] 

• Align with Abutment: False 

• Transverse Offset: 0.2700 

• Align with FFBW: True 

• Parallel to Alignment: True 

• Use Slope from Profile: False 

• Wingwall Material: Tx Abutment [ ] 

• Footing Material: Tx Abutment [ ] 

• Pile Material: Tx Drilled Shaft [ ] 

• Name Prefix: Abut1-Wingwall1 

 
 

• Select Abutment 1, left click to accept and place, then right click to end operation/reset. 
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• Once the wingwall is placed select the wingwall, and in the properties press the SELECT to 

Edit [ ] in the Wingwall Template field. 

o In the Wingwall tab change the Height to 5.8333 or  .. 70” and the Length to 18 

[3 * 5.8333] 

 
o In the Footing tab change the Footing Length to 18. 

 
Note: The wingwall and footing get clipped automatically to avoid overlapping with 

the abutment. 

o In the Piles tab press the Pattern Layout and change the Left Margin to 162 [ 

18 x 12 x 0.75] and the Right Margin to 54 [ 18 x 12 x 0.25], then press the 

Generate Piles, then press OK to accept the change. 

 
o Press OK to accept all changes to the wingwall. 

o Repeat the steps on the other wingwall. 

Knowledge Tip: Like the abutment pile layout, the piles for the wingwall can be 

controlled individually when the Manual checkmark is enabled. Everything else 

works the same way as in the pile layout dialog of the abutments. 
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• Back to the properties section, adjust the Transverse Offset to a value to aligns the 

wingwall closer to the edge of the abutment. 

Note: This offset is often miscalculated in abutments with a skew, so adjustment is 

required. 

 
• Once done making the adjustments to the first wingwall repeat the steps on the second 

wingwall. Some adjustment will be required with the offset values. 

 

15. For abutment 4 we will use a parametric cell to illustrate the differences between using a template 

vs a parametric cell. To start press the Place Custom Abutment button in the Substructure 

section. 

 

• Cell: Abut for TxGirders and Similar with DS [ ] 

• Active Angle: -00°00'00.00001" [This slight angle defines which direction the 

abutment is pointing for the start or end of the bridge, Positive (+) Start, Negative 

(-) End] 

• Cap Length Adjustment: Aligned  

• Ignore Support Line Skew: True 

• Cap Material: Tx Abutment [ ] 

• Footing Material: Tx Footings [ ] 

• Pile Material: Tx Drilled Shaft [ ] 

• Name Prefix: Abutment4 
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• Select the support line for Abutment #4, then press once again anywhere to accept the 

selection and place the abutment. 

• Now that the parametric cell is placed, we will adjust the geometry of the custom abutment 

to fit the bridge. Select the abutment, then navigate to Selection in the OpenBridge Model 

hierarchy. 

 
• Locate the Variables section in the properties and modify them. 

o Skew Angle: -10 

o Left Cross Slope (%): -1.5894 [using analyze point to find elevations at CL 

and Edge of Deck {(1167.54-1167.18)/(23*Cos(10))}*100] 

o Right Cross Slope (%): 1.5894 

o Roadway Width: 40 

o Backwall Height: 5.0074 or ..60.0888 

o Abut DS Overhang: 3’ 

o Abut DS Qty: 4 

o Wingwall Length: 18 

o All other variables should remain unchanged. 
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Note: Allow a few seconds to let the parametric cells take the new changes before making 

another variable change. Left and Right are in relation to the front face of backwall, not the 

alignment. 

Note: If the abutment appears in the wrong direction, navigate to the custom abutment in 

the hierarchy of the explorer, and then go to the Rule Property section in the properties 

dialog box. Adjust the following values. 

 

o Active Angle: 180 [if necessary to correct the longitudinal abutment 

orientation] 

16. Once the parametric cell is place, we will proceed to add the bearing pads and bearing seats. We will 

do this using the Place Bearing tool from the Substructure section. 

 
• The information used for the bearing pad and bearing seats comes from a combination of 

the standard drawings IGEB [Table of Bearing Pad Dimensions] and BIG-40 [Bearing Seat 

Details]. 

o Bearing Type: Cube 

o Cube Width, W:  1.75 [21”] 

o Cube Depth, D: 0.666 [8”] 

o Cube Height: 0.2292 [2.75”] 

o Orientation: Girder 

o Has Pad or Plate: False 

o Has Bearing Seats: True 

o Seat Min. Thickness: 0.095 [1.15” – Min thickness is measured at the edge of 

seat] 

o Seat D1: 0.75 [fwd dimension from bearing line to edge of cap] 
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o Seat D2: 1 [bk dimension from bearing line to cap cl] 

o Seat W1: 1.5 [half bearing seat width] 

o Seat W2: 1.5 [half bearing seat width] 

o Seat Orientation: Girder 

o Back Offset: -1.000 [-1 x Cos (Bent Angle) for Interior Bents] (0 for start 

abutment) 

o Ahead Offset: 1.000 [1 x Cos (Bent Angle) for Interior Bents] (0 for end 

abutment) 

Note: These are set both to 0 when a single seat and pad is required on the 

support, like is needed for continuous steel beams. 

o Pad or Plate Material: Miscellaneous > Neoprene Bearing Pads [ ] 

o Bearing Seat Material: Tx Bearing Seat [ ] 

 
• Once all settings have been defined the user can select all the support lines to which the 

settings entered apply. Press the right mouse button then the left mouse button to finish 

placement. 

Note: The Back and Ahead offsets are different for Abutments and Bents, see the applicable 

Elastomeric Bearing standard for additional information. 

17. Once all the abutments, bearing pads and bearing seats are in place the next step is to place the 

approach slabs. We will do this using the tools in the Approach Slab section. 

 
• Using the Place Approach Ref Line tool, we will place the reference line that indicates the 

end of the approach slab on both ends of the bridge. Before starting this command make 

sure Accu-draw is activated.  

o Skew Angle: 0 

o Length: 100 

o Location: Start 



 

 OpenBridge Designer/Modeler Training Manual | 51 

o First, click the Place Approach Ref Line tool and then hover the mouse over the snap 

intersection point of the inside of the wingwall and the SupportLine1 at the start of 

the bridge. 

 
o Next press the O (letter) key on the keyboard to set the origin for Accu-draw. Then 

press R and then E. Then click a point further along the wingwall to set the angle of 

the Accu-draw. 

 
o Finally, Type in -20 for the Y value in the Accu-draw menu. This is the required 

distance for the shorter end of a skewed approach slab per TxDOT Standards. Next 

click in the window three times, once to confirm the 20’ offset, once to place it, once 

to confirm the 100’ length of the Approach Reference Line. 
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• Use the Place Approach Slab tool to place the approach slab element between the 

abutment support line and approach slab reference line. 

o Location: Start 

o Template Name: Standard Templates\TxDOT Decks\Approach Slab [ ] 

o Add Constraints: True 

o Sleeper Slab: False 

o Approach Slab Material Name: Tx Approach Slab 

Optional 

o If the approach slab is placed on top of the wingwalls, the user can enable the option 

Sync with Deck and the approach slab will match the width of the deck and the 

breakbacks if any. 

o Press anywhere in the screen to accept all inputs and to place the approach slab. 
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o In the Variable Constraint dialog box, change the Left and Right widths as indicated 

below: 

 LT_Width_Lane1: Start = -22; End = -22 

 RT_Width_Lane1: Start = 18; End = 18 

 RT_Slope_Lane1: Start = 0.02; End = 0.02 

 
 

 
 

 
o Press OK to accept all changes. 

• Note: Users can adjust the Cross Section Distance value with the slide bar at the bottom of 

the window. Shown below. 
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• Use the Place Sleeper Slab to place the sleeper slab under the approach slab. 

o Place Start Sleeper Slab: True 

o Template Name: Sleeper Slab\TxDOT\5 Foot Sleeper [ ] 

o Conform with Approach Bottom: True 

o Sleeper Length Adjustment: Approach Slab and Aligned 

o Place End Sleeper Slab: False 

o Material Name: Tx Sleeper Slab 

o Click anywhere in the screen to accept settings, and then press again to place sleeper 

slab. 

  
18. Repeat all steps in step 17 to place the approach slab at the end of the bridge. The approach reference 

line and the approach slab will both need End instead of Start in the settings boxes to be properly 

placed. Also, -20’ offset will be positive 20’ at the end of the bridge. 
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19. Once the approach slabs are completed, it is time to place the needed traffic barriers. We will use the 

Place Barrier button from the Accessory section. 

 
• In the dialog box 

o Template Name: Barriers\TxDOT\_Rails with Solid Walls\SSTR_R [ ] 

o Barrier Material: Miscellaneous > Traffic Barrier [ ] 

o Pay Unit: Linear Unit 

• Left click on the main slab to select the deck to place the barrier, then Right click anywhere 

in the model to complete the selection, finally Left click to accept placement. 

• In the Path Selection dialog box, press the Select Guideline from List button. 

• Select the EOP_R from the list as the placement guide for the barrier. 

• Press OK to accept path, then press OK again to finish placement. 

 
• Repeat steps for the left side and on the other slabs using the appropriate barrier template. 

For approach slabs a Horizontal Offset of -1 or 1 is required if the approach slab is inside 

the wingwalls. 

• Multiple slabs within the same unit can be selected, for example the user can select the 2 

approach slabs to place the left or right barriers at the same time. 

 

20. This concludes the creation of the Southbound bridge model with a concrete superstructure.  

 

Some final notes: 

Build Order: This variable appears on all elements placed and is used for RM Bridge to create the 

construction stages when the engineer plans on doing the analysis of the bridge there. There is no 

other purpose for it in OBM, so no Build Order values were adjusted during the previous steps of this 

training manual. 

Materials: Like Build Order, the material is used when the engineer is planning to transfer the model 

to RM for analysis. In addition, the material is used to define the unit of measure for an element and 
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the cost per unit of measure. When using OBM to generate reports, it is important to set the correct 

material to every element. More about the material creation will be covered in the libraries section of 

this manual. 

Labels: All text labels are controlled by the annotation scale used, the annotation scale can be 

changed in the Reports and Drawings tab. 
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Exercise #1 - Create the Bridge model for the Northbound Main lanes. 

Save a copy of the file used up to this stage. This is done by navigating to File > Save As, select No Wizard 

then provide the following information. 

• Name: Exercise_01.dgn.  

• Description: Precast Concrete Exercise #1 

Using the acquired knowledge so far create the model for the Northbound Main Lanes bridge in the new file 

using the following information. 

• Bridge Name: US281 Northbound Mainlane 

• Bridge Type: Beam Slab (P/S or RC Concrete Girders) 

• NBI: 15-046-0-0253-03-053 

• Start Station: 14+35.06 

• End Station: 16+50.06 

• 3 Spans: 45 – 125 – 45 

• Left Width: -19 

• Right Width: 23 

• Left Cross Slope: -0.02 

• Right Cross Slope: -0.02 

• All other information is the same as the Southbound bridge. 

• Once the exercise is complete return to the Bridge_Model_01.dgn file to continue training. 

 

Note: It is optional to use the Edge of pavements provided and the superelevation shapes 

provided. Also, it is optional to use parametric cells for the abutments.  

This concludes the creation of the concrete girder bridge models.  
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Create a Bridge with Steel Superstructure 

This section will focus on the steel part of OBM, all other elements are the same as the previous section. 

Steps that are repeated such as the Add Bridge, Support Lines, Supports, Bearing seats, Wingwalls, etc. will 

not be covered in depth as it was done before, only the required information for the tool is provided in each 

step. 

1. Continuing in the Bridge_Model_01.dgn file. 

2. Create a new bridge with the following information.   

• Bridge Name: US281 Northbound Mainlane 

• NBI: 15-046-0-0253-03-053 

• Requires Road Alignment: False 

• Use Road Alignment For Stationing: False 

• Unit Name: Unit 1 

• Description: 215.00’ Steel Beam Unit (45’-125’-45’) 

• Bridge Type: Beam Slab (Steel Girders) 

• Name Prefix: US281_NBML 

• Select the Northbound alignment. 

3. Place the support lines with the following information.     

• Skew Angle: -10º00’00” 

• Length: 70 

• Start Station: 14+35.06 

• End Station: 16+50.06 

• Number of Support Lines: 4 

• 3 Spans: 45’ – 125’ – 45’ 

4. Place the deck with the following information.    

• Template Name: Standard Templates\TxDOT Decks\Bridge Deck [ ] 

• Add Constraints: False 

• Analytical Deck: True 

• Deck Material: Tx Deck [ ] 

• Deck Breakbacks: 0 [zero] 

• Name Prefix: MainDeck-Unit1 

• Left Width: -19 

• Right Width: 23 

• Left Cross Slope: -0.02 

• Right Cross Slope: -0.02 

Hint: Use the superelevation shapes and edge of pavement lines. Refer to Knowledge Tip on 

page 33.  
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5. Place the beam layout with the following information.     

• Left Overhang: 3.0’ 

• Right Overhang: -3.0’ 

• Number of Beams Span 1 and Span 3: 6 

• Number of Beams Span 2: 5 

• BEAM START SL Offset: 3” 

• BEAM END SL Offset: -3” 

• Skew Ends: Only Beam Start at Abutment and Beam End at Abutment 

6. Place the beams on the beam layout using the following information.   

• Built-Up: False 

• Start Cut Orientation: Vertical 

• End Cut Orientation: Vertical 

• Name Prefix: SteelBeams 

 
• For Span 1 and Span3 we will use the same type of beam and same haunch. 

o Beam Template: Rolled Shapes\AISC14-W\W40X149 

o Beam Min Haunch: 2.05” 

o Material: Rolled Wide Flange Sections 

o Setup the first beam of the first span. 

  

o Use the Beam Copy tool [ ] to copy the beam to the rest of the span and 

Span 3. 
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• Continuing in the Beam Definition dialog box, select the first beam of Span 2. 

o Beam Type: Built-Up 

o Section: Top Flange 

o Beam Min Haunch: 2.0” 

 

o We will add 3 Rows 
o Row 1: 

 Location Type: Head 

 Relative Location: 0 

 Thickness: 0.75” 

 Start Width: 14” 

 Variation: None 

 Material: Straight Plate Girders 

o Row 2: 

 Location Type: Head 

 Relative Location: 24.75’ 

 Thickness: 1” 

 Start Width: 14” 

 Variation: None 

 Material: Straight Plate Girders 

o Row 3: 

 Location Type: Tail 

 Relative Location: -24.75 

 Thickness: 0.75” 

 Start Width: 14” 

 Variation: None 

 Material: Straight Plate Girders 

 
• Select all rows in the table created using CTRL+A in your keyboard and copy the table using 

CTRL+C, then change the Section to Bottom Flange. 

• Select the first row and paste the table using CTRL+V. 

 
• After pasting the table, update the Material to be Straight Plate Girders. 
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• Once the rows get updated, change the Section to Web and create 5 total rows using the 

Add button. 

o Row 1: 

 Location Type: Head 

 Relative Location: 0 

 Thickness: 1” 

 Start Height: 36.7” 

 Variation: None 

 Material: Straight Plate Girders 

o Row 2: 

 Location Type: Head 

 Relative Location: 4.75 

 Thickness: 1” 

 Start Height: 36.7” 

 Variation: Linear 

 End Height: 54” 

 Material: Straight Plate Girders 

o Row 3: 

 Location Type: Head 

 Relative Location: 9.75 

 Thickness: 1” 

 Start Height: 54” 

 Variation: None 

 Material: Straight Plate Girders 

o Row 4: 

 Location Type: Tail 

 Relative Location: -9.75 

 Thickness: 1” 

 Start Height: 54” 

 Variation: Linear 

 End Height: 36.7” 

 Material: Straight Plate Girders 

o Row 5: 

 Location Type: Tail 

 Relative Location: -4.75 

 Thickness: 1” 

 Start Height: 36.7” 

 Variation: None 

 Material: Straight Plate Girders 

o To see the profile of the beam, press on the up arrow next to Drawing Disabled. 
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o Use the Beam Copy tool [ ] to copy the beam to the rest of the span. 

Select the spans or beams in the dialog box and press the Copy By Ratio button. 

 
• Once all the beams have been defined, press the OK button to accept the beam definition. 
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7. Once the beams are in place, we will be adding stiffeners using the Place Stiffeners tool from the 

Superstructure section. 

 
Note: The Place Stiffeners tool is used to place stiffeners that are not accompanied by a cross 

frame, or additional stiffeners at cross frame locations. 

• Select the beam group placed in the previous step. And click anywhere in the model to 

accept the selection. 

• The Place Stiffeners dialog box will open, then there are several tools in this dialog as 

described below. 

o Add – This tool will add single row to the table. 

o Insert – This tool will insert a single row to the table in between existing rows. 

Knowledge Tip: OBM also supports cover plates for top and bottom for I-Beams. In 
addition, OBM can also model Tub Girders. The same process used in the Built-Up 
girder in the previous section is used to built-up the tub girder. 

In tub girder the haunch is individually controlled at each top flange. 

 

In tub girders the input is limited for Web, Top, and Bottom flanges. Bentley has not 
yet developed close plates, or internal diaphragms. 
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o Delete – This tool deletes the selected row. 

o Delete All – This tool will delete all rows. 

o Wizard – This tool creates multiple rows for stiffeners equally spaced. 

o Copy – Copies all the stiffeners defined in the beam to another beam. 

• Using the Wizard place 3 equally spaced stiffeners on Span 1 and Span 3. 

o Number of Stiffeners: 3 

o Stiffener: TxDOT Brng 16” ¾ x 7.5” 

o Side of Web: Both 

o Start 

 Beam Start: True 

 Offset: 0.5 

o End 

 Beam End: True 

 Offset: 0.5 

  
• Press the Generate button to create the stiffener rows, and then press Close to close the 

wizard. 

• Use the Copy tool to copy the stiffeners to all beams in Span 1 and Span 3. Select the spans 

or beams in the dialog box and press the Copy By Ratio button. 
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• Select the first beam on Span 2, and using the Wizard add 5 stiffeners. 

o Number of Stiffeners: 5 

o Stiffener: 6 x 0.5 

o Side of Web: Both 

o Start 

 Beam Start: True 

 Offset: 10 

o End 

 Beam End: True 

 Offset: 10 

 
• Press the Generate button to create the stiffener rows, and then press Close to close the 

wizard. 

• Using the Add and Insert tools, add single stiffeners at the start and at the end of the 

beam. 

o Select the first row and press Insert two times. 

o Modify the first two rows as follows. 

 Start Location or Ratio: 4’ 

 Side Of Web:  One Left and One Right 

 Stiffener: TxDOT Brng 16” ¾ x 7.5” 

o Select the last row and press Add two times. 

o Modify the last two rows as follows. 

 Start Location or Ratio: 120’ 

 Side Of Web:  One Left and One Right 

 Stiffener: TxDOT Brng 16” ¾ x 7.5” 
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• Once all stiffeners have been added use the Copy tool to copy the stiffeners to all beams in 

span 2. Select the spans or beams in the dialog box and press the Copy By Ratio button. 

Note: Copy By Ratio button does not carry over the Stiffener type. That will need to be 

updated after copying. 

 
• Press the Validate button to preview the stiffener locations, and press SAVE to accept all 

and place the stiffeners. 

 

 

8. Next, we will add the cross frames using the Place Cross Frames tool from the Superstructure 

section. 

 
• Click on the beam group to start the placement of the cross frames. Then click anywhere in 

the screen. 

• Like the stiffeners, the tools available can add or delete individual rows or add or delete 

multiple rows. 

• Using the Wizard, we will add the cross frames to the beam bays in all spans. 

o The cross-frame wizard provides more options for placement. The user can place 

One-by-One or by Bulk Locations. 
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Note: In the One-By-One tab the user can enter a distance, and a location from 

where the distance is being measured. 

 
Note: In the Bulk Locations tab, the user can provide the number of locations, or 

use spacings to identify the locations. 

 If the user choses to just select the number of locations, the cross frames will 

be equally spaced. 

 If the user wants more control on the spacing, use the spacing option. The 

spacings can be grouped and can be spaced delimited. 

 e.g. 2@10’ 3@5’ 10’ 2@2.5’ 

 Unlike the stiffeners, the cross-frame wizard allows the placement of the cross 

frames to the selected bay or to all bays. 

o Use the Bulk Locations tab in the Place Cross Frames tool to populate the cross 

frames. 

 For the locations use: 

 Number of Locations: 4  

 Apply to: All Bays. 

 
 The user needs to provide the start and end location for the placement. 

 For start and end information use: 

 From SupportLine: Abut1  

 From Offset: 1.00’ 

 To SupportLine: Bent2  

 To Offset: -1.00 
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 For the cross-frame information: 

 Position Lock: Normal to Left Beam 

 Align: Vertical 

 Direction: Upstation 

 Left Stiffener: TxDOT Brng 16” ¾ x 7.5” 

 Cross-Frame: TxDOT W40 

 Right Stiffener: TxDOT Brng 16” ¾ x 7.5” 

 

o Press the Generate button to create the cross-frame rows, and then press Close to 

close the wizard. 

o Verify that all bays in Span 1 got the cross-frames. 

o Use the Copy tool, to copy the cross-frames to all bays in span 3. Select the spans 

or beams in the dialog box and press the Copy By Ratio button. 

 
o Use the Validate button to preview the locations in the drawing. This will also check 

for conflicts with previously placed cross-frames or stiffeners. 
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• Open the Cross-Frame Placement dialog box then select the first bay of the second span. 

• Use the wizard to place the cross-frames: 

o Placement method: Bulk Location 

o Number of Locations: 6  

o Apply to: Current Bay 

o From SupportLine: Bent2 

o From Offset: 9 

o To SupportLine: Bent3  

o To Offset: 9 

o Position Lock: Normal to Left Beam 

o Align: Vertical 

o Direction: Upstation 

o Left Stiffener: 6 x 0.5 

o Cross-Frame: X Frame_3 

o Right Stiffener: 6 x 0.5 

 
o Press the Generate button to create the cross-frame rows, and then press Close to 

close the wizard. 

• Add 2 frames manually using the Add button. The frame will be added at the end of the 

table. 

o Position Lock: Normal to Left Beam 

o Left Location: 3  AND 122 

o Cross-Frame: TxDOT W40 

o Orientation: Upstation 

o Align: Vertical 

o Left Stiffener: TxDOT Brng 16” ¾ x 7.5” 

o Right Stiffener: TxDOT Brng 16” ¾ x 7.5” 
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o Use the Copy tool to copy the cross-frames to all bays of Span 2. Select the spans or 

beams in the dialog box and press the Copy By Ratio button. 

 
o Use the Validate button to preview the locations in the drawing. This will also check 

for conflicts with previously placed cross-frames or stiffeners. Then press Save to 

accept all cross-frame locations. 

 
Note: If the user wants more control over where the cross-frames are placed, the distances can be 

changed after creating the rows with the bulk locations of the wizard or create one-by-one using the 

wizard. The bulk locations and the one-by-one in the wizard cannot be used in combination, it is 

either one or the other. 

 

9. We will now place field splices only in the longer span using the Place Field Splices tool from the 

Superstructure section. Splices are usually controlled by length and weight of the segments. The 

engineer should consider transportation restrictions to determine if splices are needed.  

 
• Click on the beam group to start the placement of the cross frames. Then click anywhere in 

the screen. 

• In the Place Field Splices dialog box, select the first beam of the Span 2. 
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• Input the following values: 

o Template: Field Splice_0 

o Mode: SupportLine 

o Type 65.5’ in the text input 

o From: Bent2 

o Press the Add button to add the new splice 

  
o Use the Copy tool to copy the cross-frames to all beams of Span 2. Select the spans 

or beams in the dialog box and press the Copy button. 

 

o Use the Validate button to preview the locations in the drawing, then press Save to 

accept all field splice locations. 

 

Note: If more than one splice is needed the user can enter spaces similar to how spaces are 

entered for the Cross-Frames, but in splices the user cannot use the “@” command to group 

spacing. The spacing entered must be in relation to the mode selected. 
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Note: Field splice used for this exercise is too large for our beam, we will cover how to 

create new splice plates in the library section, for now just ignore the issue. When we 

update the template used, the drawing will also update. 

 
 

10. Finally, we will place the shear studs using the Place Shear Studs located in the Superstructure 

section. 

 
• Click on the beam group to start the placement of the shear studs, then click anywhere in 

the screen. 

• In the Shear Studs Placement dialog box, select the first beam of the Span 1. 

• Press the Add button to add a new row to define the shear stud placement. 

o Location Type: Distance 

o Start Location: 1 

o End Location: 3 

o Longitudinal Spacing: 0.5 

o Shear Stud: H4L – 0.25 x 2.67” 

o Number per Row: 3 

o Transverse Spacing: 3.5 

 

• Press the Add button to add a new row to define the shear stud placement. 

o Location Type: Distance 

o Start Location: 3.5 

o End Location: 40.5 

o Longitudinal Spacing: 1.5 

o Shear Stud: H4L – 0.25 x 2.67” 

o Number per Row: 3 

o Transverse Spacing: 3.5 
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• Press the Add button to add a new row to define the shear stud placement. 

o Location Type: Distance 

o Start Location: 41 

o End Location: 44 

o Longitudinal Spacing: 0.5 

o Shear Stud: H4L – 0.25 x 2.67” 

o Number per Row: 3 

o Transverse Spacing: 3.5 

 

• Use the Copy tool to copy the shear studs to all beams of Span 1 and Span 3. Select the 

spans or beams in the dialog box and press the Copy button. 

 
• In the Shear Studs Placement dialog box, select the first beam of Span 2. 

• Press the Add button to add a new row to define the shear stud placement. 

o Location Type: Distance 

o Start Location: 1 

o End Location: 3.5 

o Longitudinal Spacing: 0.5 

o Shear Stud: H4L – 0.25 x 2.67” 

o Number per Row: 3 

o Transverse Spacing: 3.5 

 

• Press the Add button to add a new row to define the shear stud placement. 

o Location Type: Distance 

o Start Location: 4 

o End Location: 121 

o Longitudinal Spacing: 1.5 

o Shear Stud: H4L – 0.25 x 2.67” 

o Number per Row: 3 

o Transverse Spacing: 3.5 
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• Press the Add button to add a new row to define the shear stud placement. 

o Location Type: Distance 

o Start Location: 121.5 

o End Location: 123.5 

o Longitudinal Spacing: 0.5 

o Shear Stud: H4L – 0.25 x 2.67” 

o Number per Row: 3 

o Transverse Spacing: 3.5 

 

• Use the Copy tool to copy the shear studs to all beams of Span 2. Select the spans or 

beams in the dialog box and press the Copy button. 

 
• Use the Validate button to preview the locations in the drawing. Then press Save to accept 

all shear stud locations. 

• To see the shear studs in the 3D view the user will need to turn off the deck either using the 

level display or using the explorer. 

 
• After placing all steel elements, everything left to do is repeated from the previous section. 

11. Place Interior Bents.   

• Template Name: MultiColumn\TxDOT\Interior Bent for Steel Beams [ ] 

• Cap Length Adjustment: Deck and Aligned 

• Cap Material: Tx Interior Bent Cap [ ] 

• Column Material: Tx Column [ ] 

• Footing Material: Tx Drilled Shaft [ ] 

• Name Prefix for SupportLine2: Bent2 

• Name Prefix for SupportLine3: Bent3 
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12. Place Abutments at both ends of the bridge.   

• Template Name: PileCap\TxDOT\Abut for Steel Beams with DS up to 15 deg skew [

] 

• Apply Skew To Solids: True 

• Conform BackWall With Deck Top: True 

• Edit Elevation Constraints: False 

• Orientation: Start for Abutment 1 [End for Abutment4] 

• Cap Length Adjustment: Deck and Aligned 

• Cap Material: Tx Abutment [ ] 

• Pile Material: Tx Drilled Shaft [ ] 

• Name Prefix for SupportLine1: Abutment1 

• Name Prefix for SupportLine4: Abutment4 

Note: Update the Backwall Vertical Offset from Deck top in the properties to be 13”, also 

update the Backwall Depth and Backwall Vertical Offset to be 48.95” in the Template 

settings as it was done before. 

13. Place wingwalls on the left and right of each abutment and make the needed adjustments to align 

them correctly.  

• Template Name: Wingwall\TxDOT\Wingwall with Cap and DS [ ] 

• Orientation:  Normal/Skewed 

• Vertical Offset: 4.0725 [Left], 3.1025 [Right] (Swap values for Abutment 4) 

• Align with Abutment: False  

• Transverse Offset: 0.75 [Left], 0.27 [Right] (Swap values for Abutment 4) 

• Align with FFBW: True 

• Parallel to Alignment: True 

• Use Slope from Profile: True 

• Place Right Wingwall: True  [Use the exact same settings as above] 

• Wingwall Material: Tx Abutment [ ] 

• Footing Material: Tx Abutment [ ] 

• Pile Material: Tx Drilled Shaft [ ] 

• Name Prefix for SupportLine1: Abut1-Wingwall1 

• Name Prefix for SupportLine4: Abut4-Wingwall1 

Note: Since left and right wingwalls were enabled, the software will automatically number them  

Abut1-Wingwall1 & Abut-Wingwall2. Adjust the template to have a wingwall height of 4.0725’. 
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14. Place bearing pads and bearing seats. Select each SupportLine.   

• Bearing Type: Cube 

• Cube Width, W:  1.333 [16”] 

• Cube Depth, D: 0.666 [8”] 

• Cube Height: 0.2292 [2.75”] 

• Orientation: Girder 

• Has Bearing Seats: True 

• Seat Min. Thickness: 0.095 [1.15” – Min thickness is measured at the edge of seat] 

• Seat D1: 0.6666 [fwd dimension from bearing line to edge of cap] 

• Seat D2: 0.7083 [bk dimension from bearing line to cap cl] 

• Seat W1: 1.166 [half bearing seat width] 

• Seat W2: 1.166 [half bearing seat width] 

• Seat Orientation: Girder 

• Back Offset: -0.7083 [0 for Abutment 1] 

• Ahead Offset: 0.7083 [0 for Abutment 4] 

• Pad or Plate Material: Miscellaneous > Neoprene Bearing Pads [ ] 

• Bearing Seat Material: Tx Bearing Seat [ ] 

15. Place approach slabs, and sleeper slabs (see step 17 in previous section) 

16. Finally, place the traffic barrier. See step 19 of previous section and use the templates below for left 

and right barriers. 

• Template Name: Barriers\TxDOT \Rails with Posts (Use for Typ Sections) \C223_R [ 

] 

• Template Name: Barriers\TxDOT\ Rails with Posts (Use for Typ Sections) \C223_L [ 

] 

17. This concludes the creation of the bridge with a steel superstructure. Practice creating this same bridge 

on your own in the Exercise_01.dgn. 

18. Close all open sessions of OpenBridge Modeler, but keep OpenBridge Designer open if it is being used. 
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Creating a Precast Bridge Model – Using the Bridge Wizard 
This section will repeat several steps from the previous section, this is mostly to setup a new standalone 
group for a new bridge model that will be created using the Bridge Wizard in OBM. After completing exercise 
one, the user can close OBM and return to the OBD folder page. 

Create a New OpenBridge Designer file. 
If OpenBridge Designer is not getting used, please skip to page 78 to start with OpenBridge Modeler. 

1. With OpenBridge Designer still open and with the Standalone option selected, select the Add 

Standalone Group icon. 

 
 

2. Use a name that describes the type of work that is going to be stored in the group. For this training 

use Precast Bridge Wizard Training. 
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Create a New OpenBridge Modeler file. 

OBM will ask the user again to login to ProjectWise as it did before, and the same steps as before will be 

used to create a new dgn file. 

1. Open OpenBridge Modeler either by pressing the OpenBridge Modeler button in OBD or by 

pressing the OpenBridge Modeler icon in the desktop or start menu. 

 
 

2. When prompted, login to ProjectWise again using the same datasource and authentication used in 

OBD. 

 
 

3. Once OBM is loaded, ignore the WorkSpace and the WorkSet area. Press the New File to create a 

new OBM file. 

 
 

4. During the file creation verify that the seed file selected is correct and save the file to the correct 

path as shown below.  

• File creation method: No Wizard 
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• Browse to Documents\25 - CHS\Design Projects\XX-BRG300\4 - Design\Bridge\Bridge 

X\ 

Note: The XX in the project name will be replaced by the user’s first and last name. 

• Verify that the Seed is Documents\_Standards\Configuration\Organization-

Civil\TXDOT\_Bridge\OpenBridge Modeler\Seed\TxDOT_BridgeSeed3d.dgn 

• Key-in the new file name Bridge_Model_02.dgn. 

• Set the application to OpenBridge Modeler 

• When prompted accept the reload of the workspace. 
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Creating a Bridge with Concrete Superstructure – Using the Bridge Wizard 

1. Once the file is created, proceed to attach the geometry files as it was done in the previous section. 

2. Once all files have been attached. Press the Fit View   icon to fit the view around all 

attachments. 

 
 

3. We need to set the GeoCoordinate system of the OBM file to match the GeoCoordinate definition of 

the reference files as it was done in the previous section. 

4. This dataset is used for other trainings in TxDOT, we will use the Southbound main lane as in the 

previous section. 

 

5. Once the file has been setup with all the references and the contours, we are ready to create the 

new bridge using the Bridge Wizard tool located in the Bridge Setup section. 

 
 

Note: Very important, DO NOT PRESS ENTER while using the wizard, PRESS TAB. 

 

• Click on the alignment once to identify the alignment to be used, then click again to select a 

random station. Once a random station is selected use the keyboard to enter the information 

below. 

• Bridge Name: US281 Southbound Mainlane 

• Bridge Type: Beam Slab (P/S or RC Concrete Girders) 

• Alignment: SB_US281 

• Bridge Start Station: 14+18.00 

• Custom Deck 

• Deck Width:  42’ 

• Deck Thickness: 8.5” (0.7083’) 

• Spans: 45 125 45 
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• Support Skew Angles: -10 degrees 

• Beam Spacing: 7@6’ 

• Beam Template: Beams\Standard Sections\TxDOT\Tx Girders\Tx54 [ ] 

• Abutment Template: Pile Cap\TxDOT\Abut for TxGirders and Similar with DS up to 

15 deg skew [ ] 

• Pier Template: Multi Column\TxDOT\ Interior Bent with Footing [ ] 

• Left Barrier Template: TxDOT\ _Rails with Solid Walls\SSTR_L [ ] 

• Right Barrier Template: TxDOT\ _Rails with Solid Walls\SSTR_R [ ] 

 

 
 

Note: As mentioned before, entering the materials is important when generating reports, click on 

the Materials tab, and set them as follows. [ ] 

 

• Deck: Concrete\Tx Deck 

• Barrier: Miscellaneous\Traffic Barrier 

• Beam: Concrete\Tx I-Girder 

• Grout Pad/Bevel Plate: Miscellaneous\Neoprene Bearing Pads 

• Bearing: Miscellaneous\Neoprene Bearing Pads 

• Bearing Seat: Concrete\Tx Bearing Seat 

• Cap: Concrete\Tx Interior Bent Cap 
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• Column: Concrete\Tx Column 

• Footing: Concrete\Tx Footings 

• Pile: Concrete\Tx Drilled Shafts 

• Cap: Concrete\Tx Abutment 

• Footing: Concrete\Tx Footings 

• Pile: Concrete\Tx Drilled Shaft 

 

 
 

6. Once all bridge variables are defined and the optional materials are defined, the user can now press 

Enter, or OK in the dialog box. 

 

Note: Give some time for OBM to create the Bridge, the greater number of beams the longer the 

wizard can take. 

 

7. Once the bridge model has been created the following items need to be revised. Refer to the 

previous sections of this manual for detailed instructions and input values. 

• Make the Terrain Active. 

o Civil Tab > Terrain Model > Set Active Terrain   
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o Home Tab > Bridge Setup > Terrain  

• Deck adjustments. 

o Change the deck name to MainDeck-Unit1. 

o Use Point Control to change the left and right edge of the deck to match the 

edge of pavement lines (blue lines). 

o Use Assign Superelevation to apply cross slope to the deck. 

 

• Beam and Beam Layout adjustments. 

o Apply Beam skew ends. 

o Change the Beam haunch to 3.5”. 

• Support Lines 

o Change the names of the support lines to reflect the name of the support (e.g. 

Abutment1, Bent2, etc). 

• Supports 

o Rename the supports as needed to reflect the correct support name (e.g. 

Abutment1, Bent2, etc). 

o Apply Skew to solids for both Abutments. 

o Conform backwall with deck top Offset on both Abutments. 

• Bearing Pad and Bearing Seat adjustments. 

o Pad Size and orientation 

o Seat size and orientation 

• Wingwalls need to be placed. 

• Approach Slabs need to be placed. 

This concludes the creation of the concrete Southbound bridge model using the Bridge Wizard. 
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Placing excavation around footings 

This section will guide the user on how to place excavation models on footings, this tool can be used on 

Interior Bents and Abutments that contain sub-elements classified as footing. This section will also guide the 

user on how to obtain the quantities for the excavation volume. 

1. Update the elevation constraints of the Interior Bents so that the footing starts 1’ below the active 

terrain. To do so, select both bents in the Explorer and in the Properties select Elevation 

Constraints. In the Elevation Constraints dialog select the Footing tab and use the following 

information. 

• From DTM 

• Value: -1.0 [This is measured at the CL of column, it needs to be adjusted to ensure 

square footings are at least 1 ft below ground on all corners] 

• Click Apply to All  

• Click OK to close the dialog box.  

 
2. Use the Place Excavation tool from the Home > Substructure section. 

 
• Terrain Model: SH46_Existing_Terrain [Select from drop down] 

• Horizontal Offset: 3’ 

• Vertical Sheeting: False 

• Corner Sweep Angle: 5 degrees 

• Side Slope: 2:1 

• Bottom Vertical offset: 1’ 

• Bottom Horizontal offset: 1’ 

• Combined Excavation: True [To combine excavation of all footings in one bent] 

• Cut Material: Miscellaneous\Excavation [ ] 
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• Click on the Interior Bent #2 and Interior Bent #3 then click reset (Right Click) to accept the 

selection, finally click anywhere to start processing the excavation. 

 

  
 

3. The excavation details can be seen using the combination of explorer and the properties dialog. The 

user will find the excavation details in the 1st footing of the support element. 
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• The user cannot make changes of the parameters once the excavation is created. If the 

excavation is not what the user expected, it will need to be deleted and created again. 

• To delete the excavation the user can right click on the excavation in the explorer dialog and 

click delete. 
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Exercise #2 – Create the Northbound Main Lane using the Wizard. 

Save this file as Exercise_02.dgn and using the acquired knowledge use the bridge wizard to create the 

model for the Northbound Main Lanes bridge with the following information. 

• Bridge Name: US281 Northbound Mainlane 

• Bridge Type: Beam Slab (P/S or RC Concrete Girders) 

• Alignment: NB_US281 

• Start Station: 14+36.00 

• End Station: 16+51.00 

• All other information is the same as the Southbound bridge. 

• Once completed return to the Bridge_Model_02.dgn. 

This concludes the creation of the concrete girder bridge models using the Bridge Wizard.  
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Creating a Bridge with Steel Superstructure – Using the Bridge Wizard 

This section will focus on the steel part of OBM, all other elements are the same as the previous section. 

Steps will be repeated for the Bridge, Support Lines, Supports, Bearing seats, Wingwalls, etc. 

1. Continuing in the Bridge_Model_02.dgn file. 

2. We will now create a steel superstructure bridge using the Bridge Wizard tool located in the 

Bridge Setup section. 

 

 
 

Note: Very important, DO NOT PRESS ENTER while using the wizard, PRESS TAB. 

 

• Click on the alignment once to identify the alignment to be used, then click again to select a 

random station. Once a random station is selected use the keyboard to enter the information 

below. 

• Bridge Name: US281 Northbound Mainlane 

• Bridge Type: Beam Slab (Steel Girders) 

• Alignment: NB_US281 

• Bridge Start Station: 14+36.00 

• Custom Deck 

• Deck Width:  42’ 

• Deck Thickness: 8.5” (0.7083’) 

• Spans: 45 125 45 

• Support Skew Angles: -10 degrees 

• Beam Spacing: 7@6’ 

• Built-up Beam: Enable 

• Depth: 54” 

• Thickness (Web): 1” 

• Width: 14” 

• Thickness (Flanges): 0.75” 

 

Note: In the bridge wizard the user cannot add variations to the built-up beam as it was done 

in the previous steel bridge. 
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• Abutment Template: Pile Cap\TxDOT\Abut for Steel Beams with DS up to 15 deg skew[ 

] 

• Pier Template: Multi Column\TxDOT\ Interior Bent for Steel Beams [ ] 

• Left Barrier Template: TxDOT\Rails with Posts (Use for Typ Sections) \C223_L [ ] 

• Right Barrier Template: TxDOT\Rails with Posts (Use for Typ Sections) \C223_R [ ] 

 

 
 

Note: As mentioned before, entering materials is important when generating reports, click on the 

Materials tab, and set them as follows. [ ] 

 

• Deck: Concrete\Tx Deck 

• Barrier: Miscellaneous\Traffic Barrier 

• Beam: Steel\Straight Plate Girder 

• Grout Pad/Bevel Plate: Miscellaneous\Neoprene Bearing Pads 

• Bearing: Miscellaneous\Neoprene Bearing Pads 

• Bearing Seat: Concrete\Tx Bearing Seat 

• Cap: Concrete\Tx Interior Bent Cap 

• Column: Concrete\Tx Column 



 

 OpenBridge Designer/Modeler Training Manual | 90 

• Footing: Concrete\Tx Footings 

• Pile: Concrete\Tx Drilled Shafts 

• Cap: Concrete\Tx Abutment 

• Footing: Concrete\Tx Footings 

• Pile: Concrete\Tx Drilled Shaft 

 

 
 

3. Once all bridge variables are defined and the optional materials are defined, the user can now return 

to the geometry tab and click Enter, or OK in the dialog box. 

 

Note: Give some time for OBM to create the Bridge, the greater number of beams the longer the 

wizard can take. 

 

4. Once the bridge model has been created the following items need to be revised, using the previous 

section as guidance the user can complete the needed adjustments. 

• Make the Terrain Active. 

o Civil Tab > Terrain Model > Set Active Terrain   

o Home Tab > Bridge Setup > Terrain  

• Deck adjustments. 

o Change the deck name to MainDeck-Unit1. 
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o Use Point Control to change the left and right edge of the deck to match the 

edge of pavement lines (blue lines). 

o Use Assign Superelevation to apply cross slope to the deck. 

• Stiffeners, Shear Studs, Cross-Frames, and Field splices need to be added. 

• Beam and Beam Layout adjustments. 

o Apply Beam skew ends. 

o Change the Beam haunch to 3.5”. 

• Support Lines 

o Change the names of the support lines to reflect the name of the support (e.g. 

Abutment1, Bent2, etc). 

• Supports 

o Rename the supports as needed to reflect the correct support name (e.g. 

Abutment1, Bent2, etc). 

o Apply Skew to solids for both Abutments. 

o Conform backwall with deck top Offset on both Abutments. 

• Bearing Pad and Bearing Seat adjustments. 

o Pad Size and orientation 

o Seat size and orientation 

• Wingwalls need to be placed. 

• Approach Slabs need to be placed. 

 

 

 

This concludes the creation of the steel bridge model using the Bridge Wizard.  
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Placing Linear Templates in OBM 
This section of the training will cover how to apply linear templates created in ORD Template Library. The 
process of placing Linear Templates in OBM is the same as in ORD, the only difference is that geometry (e.g. 
Horizontal and Vertical alignments) created in OBM cannot be modified in ORD. While this section only 
covers the linear templates for RipRap, the concept is the same for retaining walls. This section will only 
place RipRap on a single abutment, however, the steps can be applied to connect two abutments with a 
single RipRap. 

Placing Riprap in OBM 
In this section we will be creating the riprap around one bridge abutment using the tools located in the 
Civil tab. 

 

1. Open the Bridge_Model_01.dgn file. (Via OBD or Standalone OBM) 

2. To begin, zoom in near the abutment. Turn off references as needed, select a contour line, and set 

the terrain override symbology to No, or change override template to Existing Boundary if 

needed. 

 
Note: The user may need to turn off the deck and the beams to better access the abutment, this 

can be done in the Level Display dialog by turning off levels OBM_Deck, OBM_Haunch, 

OBM_Barriers and OBM_GirderConcrete. Alternatively, the display of individual bridge elements 

can also be turned off by unchecking the item in the OpenBridge Model tab of the Explorer window. 

  OR  
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3. Using the civil tools, place a line tracing the front of the abutment cap. Use Complex By PI tool 
located in the Civil > Horizontal > Complex Geometry section. 
 

         
 

1. Set the parameters of the civil line as follows 

o Radius: 0’ 

o Back Transition Type: None 

o Ahead Transition Type: None 

o Feature Definition: Linear/Miscellaneous/Draft DNC 

o Name: Riprap Abutment <Number> 

  
2. Place the civil line tracing around the outside edge of the abutment cap and wingwalls 

following the order of the arrow. 
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4. Now we will create a profile along this line that will help us define the riprap edge. 

• Open a new view window for the profile by selecting the plan element, then either: 

o Select the Open Profile Model tool located in the Vertical section. 

 

o Or click and hold the right mouse button anywhere in the screen, then select 

View Control > 2 Views Plan/Profile from the pop-up menu. 

 

3. Select OK to Create a Dynamic Profile View. 

 

4. Follow the prompts to click on the line created, then click in the view other than the plan 

view. 

o Click on Plan Element 

o Click on View 

 

5. The view will fit and will show the active terrain. We must now create a 3D cut to display the 

abutment in the profile view. 
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o The default exaggeration of all profile views is always set to 10, the user can 

change the exaggeration in the view attributes tab of the view used for the 

profile. For this exercise we will set it to 1. 

     

 
 

o Turn all levels back ON, then use the Create 3D Cut tool to create a clip of the 

profile. 

 
o Click in the profile view once to accept method of clipping. 

 
o Create a box around the existing ground, large enough to fit the abutment 

height. 

 

o If all the elements of the abutment and wingwall do not show up, change the 

horizontal offset of the 3D clip from the line in the properties dialog. Select the 

box border, change the offset to +/-0.1, then click the Refresh 3D Cut button 

to update the profile view. Adjust the offset until both ends of the wingwall are 

displayed. 
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6. Now we will draw a profile line to define the top edge of the riprap.  

• Based on the TxDOT CADD Bridge standard drawings CRR and SRR, the riprap starts 9” 

below the cap for beam/slab type of bridges and 1’-6” for slab span, box beams or slab 

beams. For this exercise, draw the line 9” below from each end of the cap.  

• To snap to the abutment, the user needs to enable snaps in the reference.  

 

• If Accu-draw is not already active, turn it on by pressing F11 on your keyboard or 

navigating to Home > Primary and selecting Toggle Accu-draw to turn on XY coordinate-

based drafting tools. You can dock the XY input boxes to the bottom of your window.  

     

• Place a line across the front of the abutment cap using the Profile Line Between Points 

located in the Civil > Vertical section. 

       

o Snap on the top left corner of the abutment in the profile view. Press O in the 

keyboard to set the origin, then type 0.75 in the Y field and 0 in the X field of 

Accu-draw. Press the left button on the mouse to place the start of the line. 
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o Repeat the same snapping process to end the line 9” below the right corner of the 

abutment; Press O in the keyboard to set the origin, then V to rotate Accu-draw 

to match the view, then type 0.75 in the Y field and 0 in the X field of Accu-draw. 

Press the left button on the mouse to place the end of the line. 

o Note: If the end 9” offset isn’t entering into Accu-draw correctly, Snap the end of 

the line to the top right corner of the abutment then use the Element Selection 

tool under Home > Selection to click on the line end and move it down by Y = -

0.75.  

 

o Once the line below the abutment cap is in place, we will draw the lines along the 

wingwalls using the previously created line as our start point and ending at 1 foot 

before the end of the wingwall at the top. 

 

o Note: Use the Accu-draw shortcuts previously used. 
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o Repeat the same steps on the other side, at the other wingwall, drawing the lines 

from left to right. 

7. Once all 3 lines have been created, use the Profile Complex by Elements tool located in 

the Vertical section to join the 3 lines as a single profile. Left click on each line, left click in 

the view, then right click to complete. 

   

 

o Once the profile line is created, set it as the active profile using the Set Active 

Profile tool in the Vertical section 

 
o Click on the plan element first, then on the profile element. 

 

 
 

5. Once the profile is created, the user can close the profile view and we can start creating the riprap 

using an ORD Linear template. Select the Apply Linear Template tool located in the Template 

section. 
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• Lock To Start: True 

• Lock to End: True 

• Mirror: False 

• Template: TxDOT Templates\Linear Templates\Bridge\Bridge Concrete RipRap_1 [ ] 

• All other settings can be changed if desired or leave as they are. 

  
• Click on the line and profile created in the previous steps. This line represents the top of 

riprap. 

• Click through the tentative menus to accept the inputs. Be sure the location of the riprap is 

in the correct direction, not overlapping approach slab. 

 
Note: A rounded corner will be automatically created at the abutment cap. The radius of the 

corner is controlled by the riprap length, which can be defined with parametric constraints or 

point controls. 

• Once all parameters are accepted the riprap will be drawn. 
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6. Once the riprap is placed, we can change different variables to adjust the riprap geometry as 

needed. 

• Select the riprap on the left or right and hover over the element for a second to reveal the 

tentative menu. 

 
 

 

• From the tentative menu select the Corridor Object tools. 

 
• In the Corridor Objects dialog box, under the Parametric Constraints section, click the 

Add New to add a new constraint. 

 
o Lock To Start: True 

o Lock To End: False 

o Stop (End Station): 0+19.50 

o Constraint Label: RipRap_Slope 

o Start Value: -50% 

o End Value: -33.33% 

 
o Press multiple times in the screen to accept all parameters. 
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• In the Corridor Objects dialog box, add another constraint to change the slope on the 

other side of the abutment. 

o Start Station: 0+62.45 

o Lock To End: True 

o Constraint Label: RipRap_Slope 

o Start Value: -33.33% 

o End Value: -50% 

 
o Press multiple times in the screen to accept all parameters. 

• In the Corridor Objects dialog box, add another constraint to change the thickness of the 

Riprap to 5”. 

o Lock To Start: True 

o Lock To End: True 

o Constraint Label: RipRap_Thickness 

o Start Value: -0.4167 

o End Value: -0.4167 

  
o Press multiple times in the screen to accept all parameters. 
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7. The RipRap quantities can be obtained, by selecting the riprap corridor and then navigating to 

Components/Bridge_Riprap in the properties dialog. 

 
This Concludes the placement of linear templates in OBM (placing riprap). 
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Knowledge Tip: If the riprap conflicts with other elements, we can exclude them 

from the riprap. In the Corridor Objects dialog box, we can add clipping 

references. 

o Press the Clipping References and click the Add New. 

 
o Select the circular shape that represents the conflicting column bottom in 

the 3D view or by zooming into the 2D elements at elevation 0. 

     
o Right click to accept the selection and complete the corridor clip. 
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Users can also define the edge of a riprap template by drawing a shape with a civil 

line. To extend the riprap to this line, add a point control. 

  

After defining the parameters for the point control, press multiple times in the screen 

to accept all parameters, and when prompted to Locate Plan or Profile Element, 

select the civil line representing the riprap limit and the riprap edge will update to 

follow that line. All riprap templates have the point named RipRap_Limit and can 

be used for point control. 

Example of riprap before and after defining a point control for the RipRap_Limit 

(for information only): 
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Exercise #3 – Place the Riprap on Abutment #4 
 

Repeat the steps above to place riprap on Abutment 4, using the following input: 

• Riprap Thickness: 5” 

• Riprap Slope: 3:1 [-33.33% perpendicular to abutment] and 2:1 [-50% perpendicular 

to wingwalls] 

• All other information needs to be determined during placement. Use the plan and 3D view to 

see where the riprap limits need to be placed. 

This concludes the creation of riprap on the bridge model. 
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Generating Reports using the Bridge Model 
In this section we will be generating different reports using the buttons located in the Reports and 

Drawings tab in the Bridge Reporting section. For this section the user can be in any of the files created 

so far. 

Generating the Quantities Report 
The quantity report will use the elements to create a cost and quantities report, the user can hide the cost if 

that part is not needed in the report. This report will not include any civil template placed in the model, such 

as the Riprap quantities. All tables created in these reports can be copied to paste them into Excel. 

1. Start the report creation by pressing the Quantities Report button located in the Bridge 

Reporting section in the Reports and Drawings tab. 

 
• Select the Bridge, Unit and enable or disable the cost data. 

 
• Press Submit to generate the report. 

 
Note: The cost unit comes from the material definition, the user has to modify the material 

and add a cost per unit. 

• Use the tools available to print, change the orientation, add watermarks, and export the 

report. 

 
• When done, click Close button to exit the report tool. 
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Generating the Input Report 
The input report is a great report that can be used to do a QA/QC of all the inputs used while creating the 
Bridge Model. The report can be separated by units and create one report per unit or combine all units and 
have a single report for one bridge. The report can also combine all bridges available in the file. 

1. Start the report creation by pressing the Input Report button located in the Bridge Reporting 

section. 

 
• Select the Bridge, Unit and Elements to report. 

 
• Press Submit to generate the report. 

 
• Use the tools available to print, change the orientation, add watermarks, and export the 

report. 

 
• When done, click Close button to exit the report tool. 
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Generating the Deck Elevation Report 
The deck elevation report provides elevations on the deck based on the barriers, beams, or individual paths 
parallel to the alignment. The deck elevation reports can be saved for later use, so the user can create 
several different configurations to get the different elevation reports as needed. 

1. Start the report creation by pressing the Deck Report button located in the Bridge Reporting 

section. 

 
• Click on the start and the end support lines to create the report, for this example select the 

abutments support lines. 

• In the Deck Elevation Report select the following 

o Report Name: Elevation Report 

o Report Type: Consolidated 

o Points Per Span:  11 

o Add checkmarks to: 

 Left Deck Edge 

 Right Deck Edge 

 Beam Path 
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• Press the Generate button to create the report, press the Save and Close to just save the 

report for later access. 

 
• Use the tools available to print, change the orientation, add watermarks, and export the 

report. 

 
• When done, click Close button to exit the report tool. 

• The saved report is in Explorer. 
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Generating the Beam Report 
The beam report works like the beam report from BGS. The report provides beam grade, beam direction, 
true and projected lengths, and beam length between bearings. In addition, the report provides haunch 
thickness, haunch elevations, and beam elevations at top and bottom flanges. 

1. Start the report creation by pressing the Beam Report button located in the Bridge Reporting 

section. 

 
• The report will get created instantly. The user can select the number of points at where the 

elevations are reported. Our default value is 11, which provides 10 elevation points. 

 

 

 
• Use the tools available to print, change the orientation, add watermarks, and export the 

report. 

 

• When done, click Close button to exit the report tool. 
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Generating the Bearing Seat Report 
Like the bearing seat elevation report from BGS, this report will create a report with elevations at the 
centerline of bearing seat. In addition, the report will provide thickness of the seat at each corner and the 
center. 

1. Start the report creation by pressing the Bearing Seat Report button located in the Bridge 

Reporting section. 

 
• The report will get created instantly. 

 

 
• Use the tools available to print, change the orientation, add watermarks, and export the 

report. 

 
• When done, click Close button to exit the report tool. 
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Generating the Camber Report 
OBM is not a design application, so the camber values need to come from an analysis application. The user 
can copy the values from PGSuper and paste them into OBM. The camber report is very similar to the one 
generated by PGSuper. TxDOT prefers the use of PGSuper for Camber reports. 

1. Start the report creation by pressing the Camber Report button located in the Bridge Reporting 

section. 

 
• In the Beam Camber and Deflections dialog box, the user needs to enter the camber and 

deflection information. 

• Once the data is entered, the user can use the Copy Beam to copy the information of one 

beam to all beams or individual beams. 

 
• Press Save to save the camber and deflection information entered. Press Generate to 

create the camber report. 

• In the report view the user can filter the report by span, beams, and number of points per 

beam. Once configured press the Submit button to create the report. 

 
• Use the tools available to print, change the orientation, add watermarks, and export the 

report. 

 
• When done, click Close button to exit the report tool. 
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Generating the Pier Report 
The pier report provides elevations at top of cap at the edges of the cap, cap lengths, drilled shafts top and 
bottom elevations, drilled shaft lengths, column top and bottom elevations, and column lengths. This report 
is limited to OBM Templates and will not include pier information for parametric cells. 

1. Start the report creation by pressing the Pier Report button located in the Bridge Reporting 

section. 

 
• In the report view the user can filter the report by bridges, units, and piers. Once configured 

press the Submit button to create the report. 

 
• Use the tools available to print, change the orientation, add watermarks, and export the 

report. 

 
• When done, click Close button to exit the report tool. 

This concludes the bridge report generation section. 
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Creating and Manipulating Bridge Templates 

Review of the available Libraries 
TxDOT has created several template libraries, and material libraries that include elements to model a 
standard bridge. However, these libraries do not cover all possible cases and will need to be modified. The 
user can modify the templates once they have been placed, and any changes will remain within the Bridge 
Model file. Some libraries are dependent on other libraries like the Cross-Frame library depends on the 
Connection Plate library when the user wants to use connection plates in the cross frame. 

 

 

The material library needs to be updated per project per beam design. Create or copy beam materials so 
that the material reflects the f’c and f’ci for the design. 

1. This example will modify the field splice template used in the steel bridge exercise. Make the 

US281_NBML bridge the active bridge before starting. 

2. Open the field splice library by clicking on the Splices button located in the Libraries section of the 

Utilities tab. 

 
3. In the Field Splice Library dialog box, select the Web tab. 

 
4. In the Web tab, note that there is no input for the plate dimension, instead, the plate is built by the 

offsets, spacings, and number of bolts provided. 

 

 

 

 

Knowledge Tip: Currently the Template dialog boxes to open existing libraries or to 

save new libraries is not integrated with ProjectWise, so when creating new 

templates, it is recommended to copy all the template libraries located in 99 - 

Project Standards\Bridge Templates\ to somewhere in the network drive to 

share the library with others that can use it. 
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5. Recall from section 2 that our web height for the beam was 54”, the current number of rows makes 

the plate 66” tall, change the Bolts Rows from 11 to 8 and the plate size will be updated. 

 
6. When the changes are complete press the Save button to close the dialog and accept all changes. 

7. Because we modified the existing template, the bridge will be updated. If we look at the plate now, 

we will see that it now fits perfectly. 
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Creating a Deck Template 
In this section we will be creating a deck meant to be used in phased construction or divided highway. The 
control point will be located outside the deck limits and the deck will be offset to the left or right. 

1. Open View 4 in the view control tool bar. 

 
2. Press on the Decks button located in the Libraries in the Utilities tab. 

 
3. In the Template Creation dialog box, press the Open button to load the library store in your 

Network drive. (Libraries stored in ProjectWise cannot be modified at this moment).  

 
4. Once the library is loaded, navigate to the TxDOT Decks folder. 

 
5. Right click on the TxDOT Decks and select Add Template. Provide a name and description and 

press OK. 

• Name: LT Offset Deck 

• Description: Training Deck 

 

6. Click anywhere in the view 4 previously opened. 
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7. Once the WP appears in the view, use the block tool to place a block by the green point at the 

bottom of the view. 

 
8. Once the block is drawn, press the Import template from model button located at the top of the 

view. Then press Yes in the dialog box to accept the import. 

 
9. Back to the Template Creation dialog, we will rename the points of the deck. 

• P_0 > Top_R 

• P_1 > Bott_R 

• P_2 > Bott_L 

• P_3 > Top_L 

Note: For every change the user must click Save to save the changes or point rename. 
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10. Once the point names have been updated, select the Top_L 
• In the Point Constraints section change 

• Mode: Horizontal and Slope 

• Horizontal Parent: Top_R 

• Horizontal Value: -13 

• Horizontal Variable: DeckWidth 

• Slope Parent: Working Point 

• Slope Value: 0.02 

• Slope Variable: DeckSlope 

• Click Save to accept the changes. 

 

11. Select the Top_R and in the Point Constraints section change: 

• Mode: Horizontal and Slope 

• Horizontal Parent: Working Point 

• Horizontal Value: -10 

• Horizontal Variable: DeckOffset 

• Slope Parent: Working Point 

• Slope Value: 0.02 

• Slope Variable: DeckSlope [Select from drop down list] 

• Click Save to accept the changes. 
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12. Select the Bott_R and in the Point Constraints section change: 

• Mode: Horizontal and Vertical 

• Horizontal Parent: Top_R 

• Horizontal Value: 0 

• Horizontal Variable: <Leave Blank> 

• Vertical Parent: Top_R 

• Vertical Value: -0.7083 [8.5”] 

• Vertical Variable: DeckThickness 

• Click Save to accept the changes. 

 

13. Select the Bott_L and in the Point Constraints section change: 

• Mode: Horizontal and Vertical 

• Horizontal Parent: Top_L 

• Horizontal Value: 0 

• Horizontal Variable: <Leave Blank> 

• Vertical Parent: Top_L 

• Vertical Value: -0.7083 [8.5”] 

• Vertical Variable: DeckThickness [Select from drop down list] 

• Click Save to accept the changes. 
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14. Once all variables have been created and all points are constrained, right click on the name of 

template, and select Verify. This will open a separate window where the user can test the variables 

and the new template. 

 
15. The template is meant to be used as the left side of a divided highway or phase construction with a 

single alignment, to create the right side right click on the template name and select Copy, then 

select the newly copied template, right click on it, and select Mirror. The user will need to revise 

and verify that the mirrored template works properly before using it. 

16. This concludes the creation of the deck template. The user can now close the Template Creation 

dialog box. 

Note: The user will need to load the library from the network location in order to use any new 

template since these are not saved in ProjectWise. 
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Creating a Rail Template 
In this section we will be creating a traffic barrier (T223). The control point will be located outside of the rail 
element since most rails in TxDOT get placed 1.5” from the edge of the deck. 

1. Open View 4 in the view control tool bar. 

 
2. Press on the Barriers button located in the Libraries in the Utilities tab. 

 
3. In the Template Creation dialog box, press the Open button to load the library store in your 

Network drive. (Libraries stored in ProjectWise cannot be modified at this moment).  

 
4. In the Template Creation dialog box navigate to the Barriers/TxDOT folder. 

 
5. Right click on the TxDOT and select Add Category. Provide a name and press OK. 

• Name: Training Barriers 

 
 

6. Right click on the Training Barriers and select Add Template. Provide a name and description and 

press OK. 
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• Name: New T223 Barrier LT 

• Description: Left T223 Barrier 

 

7. Click anywhere in the view 4 previously opened. 

8. Once the WP appears in the view, use the smart line tool to place a polygon by the green point at 

the bottom of the view. Trace a shape like the T223 barrier but does not need to be exact. 

        
Note: The polygon does not need to be exact, it only needs the correct number of lines and 

vertices. 

9. Once the polygon is drawn, press the Import template from model button located at the top of 
the view. Then press Yes in the dialog box to accept the import. 
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10. Back to the Template Creation dialog, we will rename the points of the deck. 

• P_0 > Post_Bott_R 

• P_1 > Post_Top_R 

• P_2 > Barrier_Bott_R 

• P_3 > Barrier_Top_R 

• P_4 > Barrier_Top_L 

• P_5 > Barrier_Bott_L 

• P_6 > Post_Top_L 

• P_7 > Post_Bott_L 

Note: For every change the user must click Save to save the changes or point rename. 

 

11.  Now we will correct the rail dimensions to match the TxDOT standard size by adjusting the 

constraints of each point. Select the Post_Bott_R and in the Point Constraints section change: 

• Mode: Horizontal and Vertical 

• Horizontal Parent: Working Point 

• Horizontal Value: 0.125 [1.5”] 

• Horizontal Variable: <Leave Blank> 

• Vertical Parent: Working Point 

• Vertical Value: 0 

• Vertical Variable: Drain_Slot_H 

• Click Save to accept the changes. 
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12. Select the Post_Bott_L and in the Point Constraints section change: 

• Mode: Horizontal and Vertical 

• Horizontal Parent: Post_Bott_R 

• Horizontal Value: 0.7916 [9.5”] 

• Horizontal Variable: Post_Width 

• Vertical Parent: Post_Bott_R 

• Vertical Value: 0 

• Vertical Variable: <Leave Blank> 

• Click Save to accept the changes. 

 

13. Select the Post_Top_L and in the Point Constraints section change: 

• Mode: Horizontal and Vertical 

• Horizontal Parent: Post_Bott_L 

• Horizontal Value: 0 

• Horizontal Variable: <Leave Blank> 

• Vertical Parent: Post_Top_R 

• Vertical Value: 0 

• Vertical Variable: <Leave Blank> 

• Click Save to accept the changes. 
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14. Select the Post_Top_R and in the Point Constraints section change: 

• Mode: Horizontal and Vertical 

• Horizontal Parent: Working Point 

• Horizontal Value: 0.125 [1.5”] 

• Horizontal Variable: <Leave Blank> 

• Vertical Parent: Working Point 

• Vertical Value: 1.0833 [1’-1”] 

• Vertical Variable: Post_Height 

• Click Save to accept the changes. 

 

15. Select the Barrier_Bott_R and in the Point Constraints section change: 

• Mode: Horizontal and Vertical 

• Horizontal Parent: Post_Top_R 

• Horizontal Value: -0.125 [1.5”] 

• Horizontal Variable: <Leave Blank> 

• Vertical Parent: Post_Top_R 

• Vertical Value: 0 

• Vertical Variable: <Leave Blank> 

• Corner Attributes Mode: Chamfer 

• Corner Attributes Distance: 0.0625 [3/4”] 

• Corner Attributes Variable: Chamfer 

• Click Save to accept the changes. 
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16. Select the Barrier_Top_R and in the Point Constraints section change: 

• Mode: Horizontal and Vertical 

• Horizontal Parent: Barrier_Bott_R 

• Horizontal Value: 0 

• Horizontal Variable: <Leave Blank> 

• Vertical Parent: Barrier_Bott_R 

• Vertical Value: 1.5833 [1’-7”] 

• Vertical Variable: Barrier_Height 

• Corner Attributes Mode: Chamfer 

• Corner Attributes Distance: 0.0625 [3/4”] 

• Corner Attributes Variable: Chamfer 

• Click Save to accept the changes. 

 

17. Select the Barrier_Top_L and in the Point Constraints section change: 

• Mode: Horizontal and Vertical 

• Horizontal Parent: Barrier_Bott_L 

• Horizontal Value: 0 

• Horizontal Variable: <Leave Blank> 

• Vertical Parent: Barrier_Top_R 

• Vertical Value: 0 

• Vertical Variable: <Leave Blank> 

• Corner Attributes Mode: Chamfer 

• Corner Attributes Distance: 0.0625 [3/4”] 

• Corner Attributes Variable: Chamfer 

• Click Save to accept the changes. 
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18. Select the Barrier_Bott_L and in the Point Constraints section change: 

• Mode: Horizontal and Vertical 

• Horizontal Parent: Barrier_Bott_R 

• Horizontal Value: 1.2916 [1’-3.5”] 

• Horizontal Variable: Barrier_Width 

• Vertical Parent: Barrier_Bott_R 

• Vertical Value: 0 

• Vertical Variable: <Leave Blank> 

• Corner Attributes Mode: Chamfer 

• Corner Attributes Distance: 0.0625 [3/4”] 

• Corner Attributes Variable: Chamfer 

• Click Save to accept the changes. 

 
 

19. Once all variables have been created and all points are constrained, right click on the name of 

template, and select Verify. This will open a separate window where the user can test the variables 

and the new template. 
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20. The template is meant to be used as the left side of a bridge, to create the right side right click on 

the template name and select Copy, then select the newly copied template, right click on it and 

select Mirror and rename the template so that it indicates is the right side. 

 

 
 

21. This concludes the creation of the barrier template. The user can now close the Template Creation 

dialog box. 

 

 

 

 

 

 

 

 

Knowledge Tip: For the barrier in this exercise, we use Horizontal and Vertical 

variables for placement. By doing this we can control the height of the rail and 

create drain slots of post gaps using the variable constraints dialog box. 

The other option for placing barrier is using the Horizontal and Elevation 

Provider variables. The elevation provider places that point directly on top of the 

deck. However, this option does not allow to change the height of the point in 

relation to the deck. This option is great for Barriers that will never have Drain Slots 

or for Sidewalks. 
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Exercise #4 – Create a Sidewalk Template 

This exercise can be completed in the active file. Repeat the steps for creating a rail template (above) to now 

create a new template for a sidewalk. Sidewalks can be created as a deck template or as a barrier template, 

for this example it will be created as a barrier template. 

1. Navigate to Utilities > Libraries and select Barriers to open the Template Creation dialog. 

2. Since sidewalks are modeled longitudinally like a bridge rail, we will create a new template under the 

Barrier folder. Navigate to Barrier > TxDOT, right click to select Add Category and name the new 

folder Training Sidewalks. 

3. Right click on this new Training Sidewalks folder and select Add Template. 

• Name: LT Sidewalk 

• Description: Left Sidewalk 

• Click OK 

4. Repeating the process for the rail template, click in view 4, then use the smart line tool to trace the 

cross section of a sidewalk. For this training, draw a 6” thick, 10 ft wide sidewalk: 

 
5. Select the Import template from model button then press Yes in the dialog. 

 
6. Rename the points of the sidewalk, clicking Save to update each line: 

• P_0 > Sidewalk_Top_L 

• P_1 > Sidewalk_Top_R 

• P_2 > Sidewalk_Bott_R 

• P_3 > Sidewalk_Bott_L 
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7. Adjust the point constraints to attach the sidewalk bottom to the bridge deck, add a ¾” chamfer to 

the left top and left bottom corners of the sidewalk, and add a 2” fillet to the top right corner to 

represent the curb per TxDOT standard drawing BRSM. See Sidewalk_Top_R Point Constraints on how 

to adjust your toe offset. 

 

• Select the Sidewalk_Bott_L and in the Point Constraints section change: 

o Mode: Horizontal and Elevation Provider 

o Horizontal Parent: Sidewalk_Top_L 

o Horizontal Value: 0 

o Horizontal Variable: <Leave Blank> 

o Elevation Provider: <Leave Blank> 

o Corner Attributes Mode: Chamfer 

o Corner Attributes Distance: 0.75/12 [3/4”] 

o Corner Attributes Variable: Chamfer 

o Click Save to accept the changes 
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• Select the Sidewalk_Bot_R and in the Point Constraints section change: 

o Mode: Horizontal and Elevation Provider 

o Horizontal Parent: Sidewalk_Bott_L 

o Horizontal Value: 10 

o Horizontal Variable: Sidewalk_Width 

o Elevation Provider: <Leave Blank> 

o Corner Attributes Mode: <Leave Blank> 

o Click Save to accept the changes 

 
• Select the Sidewalk_Top_L and in the Point Constraints section change: 

o Mode: Horizontal and Vertical 

o Horizontal Parent: Working Point 

o Horizontal Value: 0 

o Horizontal Variable: <Leave Blank> 

o Vertical Parent: Sidewalk_Bott_L 

o Vertical Value: 0.5 

o Vertical Variable: <Leave Blank> 

o Corner Attributes Mode: Chamfer 

o Corner Attributes Distance: 0.75/12 [3/4”] 

o Corner Attributes Variable: Chamfer 

o Click Save to accept the changes 
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• Select the Sidewalk_Top_R and in the Point Constraints section change: 

o Mode: Horizontal and Vertical 

o Horizontal Parent: Sidewalk_Bott_R 

o Horizontal Value: -2/12 [2”] 

o Horizontal Variable: <Leave Blank> 

o Vertical Parent: Sidewalk_Bott_L 

o Vertical Value: 0.5 

o Vertical Variable: <Leave Blank> 

o Corner Attributes Mode: Fillet 

o Corner Attributes Distance: 2/12 [2”] 

o Corner Attributes Variable: Fillet 

o Click Save to accept the changes 

 
• Close the Template Creation dialog. 

8. Place your new sidewalk template. Select the Place Barrier tool from Home > Accessory. 

• Template Name: LT Sidewalk 

• Name Prefix: Sidewalk 
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• Data point on the bridge deck in View 3, right click to reset, then data point again. 

• Now we will define a line along the deck to be used as a reference for placing the sidewalk. 

In the Path Selection dialog, click Select Guideline from List 
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• Since we want to place the left sidewalk along the left top edge of the deck, choose EOP_L 

then click OK. 

 

• Click OK to close the Path Selection dialog and place the sidewalk. 

• Example result: 

 
9. Practice this exercise once more, this time creating a template named RT Sidewalk for the right 

sidewalk. Keep in mind the Path Selection places the element based on the position of the working 

point, so draw the cross section for the right sidewalk so that the WP will be at the top right corner. 

 

This concludes the tutorial on creating and manipulating bridge templates. 
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Plan Production Tools 

Bridge Layout 
In this section we will create a bridge layout using the Plan Production tools within OBM, these tools are the 

same ones available in MicroStation and ORD. For Bridge Layouts, the process is the same as creating Plan 

and Profile sheets in ORD. We will create a plan boundary and a profile boundary. 

Note: Creation of Bridge Layouts is not fully automated. Bridge Layouts are created with a combination of 

manually drawn elements and automatic 2D shapes gathered from the 3D models of the bridges. 

1. While in OBM, open the Completed Bridges.dgn located in the Bridge\Bridge x\Completed\ 

folder. 

 
2. Once the file opens, the required views will be already setup. 

Note: The views were opened by performing a long right click and selecting  

View Control > 3 Views/Plan/Profile/3D like what was done when the riprap was created to 

open the profile view of the abutments. 
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3. Add a 3D Cut to the profile view to display the bridge elements. 

    
Note: Adjust the 3D Cut offset until the profile is showing what is needed, add additional 3D Cuts 

with different offsets as needed. 

4. Create the plan boundary using the Place Name Boundary tool located in the Drawings section of 

the Reports and Drawings tab. 

 
• Press anywhere in the plan view to activate the view. 

• Select the first icon at the top of the dialog. 

• In the plan view select the Southbound Alignment.  

• In the plan view select the start and end limits of your sheets, the sheet boundaries will 

show make sure you only get the needed boundaries to capture the bridge. 

• Back to the Place Boundary dialog box. 

o Drawing Seed: Bridge Layout – Plan 

o Detail Scale: 1”=20’ 

o Name: Layout Plan 

o Start Station: 12+80.00 

o End Station: 17+40.00 

o Create Drawing: False 

o Boundary Chords: 20 
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• Press again anywhere in the plan view to complete the creation of the boundaries. 

 
5. Create the profile boundary using the Place Name Boundary tool located in the Drawings section 

of the Reports and Drawings tab. 

 
• Press anywhere in the profile view to activate the view. 

• Select the third icon at the top of the dialog. 

• In the profile view select the white profile line. 

• Back to the Place Boundary dialog box. 

• Drawing Seed: Bridge Layout – Profile 

• Detail Scale: 1”-20’ 

•  Name: Layout Profile 

• Method: From Plan Group 

• Use Active Vertical: True 

• Create Drawing: True 

• Show Dialog: True 
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• Press anywhere in the profile view to accept and create the boundaries, and the Create 

Drawing dialog will open. 

• In the Plan side (Left) 

o View Name: Bridge Layout Plan 

o Drawing Model Name: Layout Plan 01 

o Enable the Filename field by checking the toggle. 

 Press the Create new Drawing file   

 Select No Wizard and press OK 

 Save the new file to folder 4 - Design\Bridge\Bridge X\ 

 File Name: Layout Drawings.dgn 

 Description: Drawing Models for Bridge Layout 

 Press Save to create file. 

 
o Scale: 1”=20’ 

o Annotation Group: Brg Plan 20Scl 

o Sheet Model Name: Bridge Layout Sheet 01 

o Enable the Filename field by checking the toggle. 

 Press the Create New Sheet File   

 Select No Wizard and press OK 

 Save the new file to folder 4 - Design\Bridge\Bridge X\ 

 File Name: Layout Sheets.dgn 

 Description: Sheet Models for Bridge Layout 

 Press Save to create file. 
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o Scale: Full Scale 1 =1 

o Detail Scale: 1”=20’ 

• In the Profile side (Right) 

o View Name: Bridge Layout Profile 

o Drawing Model Name: Layout Profile 01 

o Enable the Filename field by checking the toggle. 

 Press the Browse Drawing file     

 Open the previously created file: Layout Drawings.dgn 

o Scale: 1”=20’ 

o Annotation Group: Brg Profile 20Scl 

o Sheet Model Name: Bridge Layout Sheet 01 

o Scale: Full Scale 1 =1 

o Detail Scale: 1”=20’ 

 

 
 

• Press OK to create the sheets and drawings. 

• The process may take some time depending on the number of sheets getting created and at 

times the process will ask the users to Update Server Copy or to Check In files in 

ProjectWise. 

• When the process is done it will open on the Sheet model file, on the last sheet of the 

process. 



 

 OpenBridge Designer/Modeler Training Manual | 140 

 
• Return to the Completed Bridges.dgn to create the Typical section drawing. 

 

6. Create the typical section boundary using the Place Name Boundary tool located in the Drawings 

section of the Reports and Drawings tab. 

 
• Press anywhere in the plan view to activate the view. 

• Select the fourth icon at the top of the dialog. 

• In the plan view select the Southbound Alignment.  

• In the plan view select the start and end locations for the sections. 

• Back to the Place Boundary dialog box. 

• Drawing Seed: Bridge Layout – Transverse 

• Detail Scale: 1”-20’ 

• Name: SB_US281-Section 

• Start Station: 15+00 

• End Station: 15+00 

• Top Clearance: 5 

• Bottom Clearance: 5 

• Create Drawing: True 

• Show Dialog: True 
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• Press anywhere in the plan view to create the boundary, and the Create Drawing dialog 

will open. 

o View Name: Bridge Layout Section 

o Drawing Model Name: Layout Section 01 

o Enable the Filename field by checking the toggle. 

 Press the Browse Drawing file     

 Open the previously created file: Layout Drawings.dgn 

o Scale: 1”=20’ 

o Sheet Model Name: Bridge Layout Sheet 03 

o Enable the Filename field by checking the toggle. 

 Press the Browse Sheet file     

 Open the previously created file: Layout Sheets.dgn 

o Sheets: Bridge Layout Sheet 01 

o Scale: Full Scale 1 =1 

o Detail Scale: 1”=20’ 

    

• The section drawing will get referenced into the sheet selected, in this case Bridge Layout 

Sheet 01. 
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Note: If the bridge varies on the number of beams per span, the user needs to create more 

sections to reflect the spans and number of beams. 

 

7. Once all drawings are created, all annotations and additional drafting will be done in the Drawing 

models. 

8. Refer to the Bridge Detailing Guide and the Bridge OBM Workflow documents to finish the 

detailing of the Bridge Layout. This concludes the Bridge Layout section. 

Note: The scale used in the example turned out to be too small, in production the user needs to 

make the decision that best fits their needs for the scale and if the typical section needs its own 

sheet. 
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Superstructure Drawings 
In this section we will create superstructure drawings using a combination of the previously used Place 

Named Boundary tools. This example will create the span sheet, the same steps can be followed to create 

the framing plan. This example will not fully annotate the drawings, for that the user will need to refer to the 

Bridge Detailing Guide and the Bridge OBM Workflow documents. 

1. Create the plan boundary using the Place Name Boundary tool located in the Drawings section of 

the Reports and Drawings tab. 

 
• Press anywhere in the plan view to activate the view. 

• Select the first icon at the top of the dialog. 

• In the plan view select the Southbound Alignment.  

• In the plan view select the start and end limits of your sheets, for these sheets the approach 

slabs do not need to be included. 

• Back to the Place Boundary dialog box. 

• Drawing Seed: Bridge Details – Plan 

• Detail Scale: 1”-20’ 

•  Name: Span Sheet Plan 

• Start Station: 14+11.00  

• End Station: 16+41.00  

• Create Drawing: True 

 
• Press again anywhere in the plan view to create the boundaries. 
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2. In the Create Drawing dialog: 

• View Name: Span Sheet Plan 01 

• Drawing Model Name: Span Sheet Plan 01 

• Enable the Filename field by checking the toggle. 

o Press the Create New Drawing File   

o Select No Wizard and press OK 

o Save the new file to folder 4 - Design\Bridge\Bridge X\ 

o File Name: Span Sheet Drawings.dgn 

o Description: Drawing Models for Span Sheets 

o Press Save to create file. 

• Scale: 1”=20’ 

• Sheet Model Name: 215.00 Prestr. Conc. I Girder Unit Sheet 01 

• Enable the Filename field by checking the toggle. 

o Press the Create New Sheet File   

o Select No Wizard and press OK 

o Save the new file to folder 4 - Design\Bridge\Bridge X\ 

o File Name: Span Sheets.dgn 

o Description: Sheet Models for Span Sheets 

o Press Save to create file. 

• Scale: Full Scale 1 = 1 

• Detail Scale: 1”=20’ 

 

• Press OK to create and open the sheets, the process will request the user to update and 

check in files in ProjectWise as it creates the different models. 

• All annotations, element manipulations and additional drafting will be done in the Drawing 

models of the span sheet. It is always recommended to minimize the amount of “live” data 

placed in the sheet models. 
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4. Return to the Completed Bridges.dgn to create the transverse section for the span sheets. The 

process will be like the creation of the plan view. We will create another cross section named 

boundary for the span sheet. 

5. Create the transverse section boundary using the Place Name Boundary too located in the 

Drawings section of the Reports and Drawings tab. 

 
• Press anywhere in the plan view to activate the view. 

• Select the fourth icon at the top of the dialog. 

• In the plan view select the Southbound Alignment.  

• Back to the Place Boundary dialog box. 

• Drawing Seed: Bridge Details – Transverse 

• Detail Scale: 1/4”=1’-0” 

• Name: Span Sheet Transverse 

• Start Station: 15+50.16 [Using mouse click around this station] 

• End Station: 15+50.16 [Do not move the mouse and press again] 

• Left Offset: -29.0 

• Right Offset: 25.0 

• Top Clearance: 5 

• Bottom Clearance: 5 

• Create Drawing: True 

• Show Dialog: True 

 
 

• In the Create Drawing dialog. 

• View Name: Span Sheet Transverse 01 

• Drawing Seed: Bridge Details - Transverse 
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• Drawing Model Name: Span Sheet Transverse 01 

• Enable the Filename field by checking the toggle. 

o Press the Browse Drawing file     

o Open the previously created file: Span Sheet Drawings.dgn 

• Scale: ¼” = 1’-0” 

• Sheet Model Name: 215.00 Prestr. Conc. I Girder Unit Sheet 02 

• Enable the Filename field by checking the toggle. 

o Press the Browse Drawing file     

o Open the previously created file: Span Sheets.dgn 

o Sheets: 215.00 Prestr. Conc. I Girder Unit Sheet 01 

• Scale: Full Scale 1 = 1 

• Detail Scale: ¼” = 1’-0” 

 

• Press OK to create and open the sheets, the process will request the user to update and 

check in files in ProjectWise as it creates the different models. 

• If for some reason the selected scales are not held, simply change the scale of the reference 

files. The scales will still need to be adjusted to fit the space and the needs of the user. 

• Like before, the drawing model needs to be used for all annotations and additional drafting. 
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• Repeat steps 1 and 2 to create the drawing and sheet model files for the framing plan, 

change the view, drawing model, drawing model file, sheet model, and sheet model file 

names to reflect framing plan. 

• This concludes the creation of the superstructure drawings. 
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Substructure Drawings 
In this section we will create substructure drawings using a combination of the substructure OBM tools and 

the Drawing Callout tools. This example will create the bent sheet, but the same concept can be applied to 

create the abutment sheet. This example will not fully detail and annotate the drawings, for that the user 

will need to refer to the Bridge Detailing Guide and the Bridge OBM Workflow documents. 

Note: If the user is using Pro-Concrete to detail all structural reinforcing the drawing/sheet creation should 

be performed from the Pro-Concrete Model, for this example we are not using Pro-Concrete, so we are using 

the OBM Bridge model for the drawing/sheet creation. 

1. First, we need to set the TxDOT Symbols as our default detailing symbols. To do so navigate to the 

Drawing task, then select the Annotate tab and press on the “Open Dialog” icon of the Detailing 

section. 

 
2. In the Detailing Symbol Styles dialog box select the TxDOT_Symbols then press the Activate 

button. Once active the style will be preceded by a green checkmark indicating that the style is 

active. Close the dialog box once the style is activated. 

       
3. Return to the OpenBridge Modeler task and setup the OBM drawing settings using the Settings 

tool located in the Drawings section of the Reports and Drawings tab. 

 
4. In the Drawings: Dynamic View Settings dialog box. 

• Auto Dimensions: False 

• Clip: False 

• Auto Fit: False 

• Unit System: English 

• Hidden Style Name: _TxDOT_Bridge_Substructure 

• Dimension Style Name: _TxDOT_Brg-Fract-Dim 

• Dual Dimension Style Name: _TxDOT_Brg-Fract-Dim-2Lines 
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• Title Text Style Name: _TxDOT_Brg_Main-Title-Text 

• Drawing Seed Model: _TxDOT_Bridge_Substructure 

• Pier Reference Copies: All Off 

• Click OK to accept all settings and close the dialog. 

 
Note: The reason why TxDOT toggles off the options mentioned, is because these tend to 

label items that we do not usually label and the effort to delete the annotations and re-

create the labeling is the same as if the annotation were never there. In addition, the reason 

why the only view created is the elevation is because TxDOT likes to keep each view in its 

own drawing model, OBM will create all views in the same drawing model if the reference 

copies are enabled. 

5. Once all settings are setup, press on the Substructure tool in the Drawing section to start the 

drawing creation workflow. 

 
6. Click on the Interior Bent No. 2 OBM element. Then press once again anywhere in the screen to 

accept the location of the element boundary. 

 
7. In the Create Drawing dialog 

• Name: Interior Bent No 2 Elevation 

• Drawing Model Name: Interior Bent Elevation 

• Enable the Filename field by checking the toggle. 

o Press the Create New Drawing File   

o Select No Wizard and press OK 
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o Save the new file to folder 4 - Design\Bridge\Bridge X\ 

o File Name: Bent Drawings.dgn 

o Description: Drawing Models for Bent Sheets 

o Press Save to create file. 

• Scale: ¼” =1’-0” 

• Sheet Model Name: Interior Bent No. 2 

• Enable the Filename field by checking the toggle. 

o Press the Create New Sheet File   

o Select No Wizard and press OK 

o Save the new file to folder 4 - Design\Bridge\Bridge X\ 

o File Name: Bent Sheets.dgn 

o Description: Sheet Models for Bent Sheets 

o Press Save to create file. 

• Scale: Full Scale 1 = 1 

• Detail Scale: ¼” =1’-0” 

 
• Press OK to create the drawing and sheet files and models. 

 

• Like in the layouts, and span sheets the additional detailing and annotations will be done in 

the drawing models. 
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8. Open the Bent Drawings.dgn, we will create the section view for the bent in this file. 

9. Once the file is open, navigate to the Drawing task, then select the Drawing Aids tab and enable 

Accu-draw by pressing on the Toggle Accu-draw tool in the Accu-draw section. 

 
10. Now navigate to the Drawing task, then select the Annotate tab and press on the Section Callout 

tool in the Detailing section. 

 
11. In the Place Section Callout dialog 

• Drawing Seed: _TxDOT_Bridge_Section_Cut 

Note: _TxDOT_Section will also work, it has the same settings this seed comes from the 

MicroStation configuration. If the user opens this drawing with MicroStation the 

_TxDOT_Bridge seeds will not be available. 

• Height: From View 

• Create Drawing: True 
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12. Place the section callout in between the columns starting from the top and drawing to the bottom, 

be sure the section is “looking” to the left side of the bent. 

 
13. In the Create Drawing dialog box 

• Name: Interior Bent Section A-A 

• Be sure the Filename toggle is set to False or Untoggled 

• Scale: ¼” =1’-0” 

• Create Sheet Model: False 

• Press OK to create the drawing model within the same file. 

 

14. Once the section drawing has been created return to the elevation model, so we can create the plan 

view drawing. 
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15. Create the plan view using the Plan Callout tool in the Detailing section of the Annotation tab. 

 
16. In the Place Plan Callout dialog 

• Drawing Seed: _TxDOT_Bridge_Plan_View 

Note: _TxDOT_Plan will also work, it has the same settings this seed comes from the 

MicroStation configuration. If the user opens this drawing with MicroStation the 

_TxDOT_Bridge seeds will not be available. 

• Create Drawing: True 

 
17. Place the plan callout just above the bent, starting from the left side and ending on the right side, 

and dragging down just enough to capture the height of the cap. 

 
18. In the Create Drawing dialog box 

• Name: Interior Bent Plan 

• Be sure the Filename toggle is set to False or Untoggled 

• Scale: ¼” =1’-0” 

• Create Sheet Model: False 

• Press OK to create the drawing model within the same file. 

 

Note: When the plan view opens, the user will notice that the Plan Callout tool does not have 

a limit on what to show “In” and “Out” of the page during the drawing creation. This can be 

changed in the properties of the plan callout. 
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19. To change the depth of the plan callout, select the plan callout then change the Bottom Height and 

Top Height in the Clip Volume section in the Properties dialog. 

• Bottom Height: 5 

• Top Height: 5 

 
Note: Bottom Height controls the distance that in the up-station direction while the Top Height 

controls the down-station direction. This direction may change in abutments. 

 

20. Once all the additional drawings are created with completed detailing and annotations, the user will 

need to manually attach the references into the sheets. 

• When referencing new drawing models to existing sheet files be sure to have the live nesting 

enabled and set to 99. 

 

21. This concludes the plan production section. The creation of the other detail sheets is a combination 

of the tools showed so far, the abutment sheets will have more drawings since there are more 

sections required. See Appendix A for example sheets created using this same process. 

22. This concludes the substructure drawings section. 
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Interoperability 
This section will focus on the export tools and what is exported to each of the supported applications. 

The Interoperability section is in the Utilities tab in OBM, this section contains all the export/import tools for 

the supported applications.  

 

 

Exporting to LEAP Concrete or LEAP Steel 
• To export to LEAP Concrete, the OBM Bridge superstructure unit can be any bridge type except 

Beam Slab (Steel Girders) and must be active. 

• To export to LEAP Steel, the OBM Bridge superstructure unit must be defined as Beam Slab (Steel 

Girders) and must be active. 

• When exporting a bridge to LEAP Concrete and the user is using OBD/OBM, the LEAP file will be 

saved within the OBD file. When the user is using OBM standalone, the user must have a standalone 

version of LEAP installed. Since Bentley has stopped developing standalone LEAP applications, if the 

user intends to use LEAP and RM, install OBD rather than OBM standalone. 

• There is no tool to import a bridge model created in LEAP into OBM, OBM can only read analytics 

information of a bridge model originally created in OBM. 

• If the bridge has multiple units, OBM will only transfer the active unit. 

• When the user sets up the OBD workflow as Standalone, the user can modify the model in LEAP, 

however, the changes in the model will not be pushed back. In the BIM workflow the OBM model 

controls all the model changes. 

1. To export a model to LEAP, press the LEAP Bridge Concrete icon or the LEAP Bridge Steel icon. 

       
2. Please refer to Appendix B or Appendix C for the OBD 2022 R2 transfer report to see the 

assumptions and limitations of the transfer in LEAP Concrete and LEAP Steel 
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Example model export in LEAP Concrete 

 
3. Example model export in LEAP Steel 

 
This concludes the exporting to LEAP tutorial. 
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Exporting to RM Bridge 
RM Bridge can accept Concrete or Steel superstructures. 

RM Bridge files can be saved within the OBD file or outside in a separate directory. This option can be 

changed in File > Settings in the OBD dialog box, however, this is only when the user is working as a 

standalone workflow, when the users are in the BIM workflow the option gets ignored and the RM bridge 

files are stored in the OBD file. 

 

Unlike LEAP, the user can select exactly what components to transfer to RM, and the user can select all 

units, and all bridges, RM will always export the active Bridge/Unit. 

 

As mentioned before, the materials and build order are important for RM Bridge as those are get used to 

analyze and create the stages when the model gets exported. 

1. To start the export to RM Bridge, press the RM Bridge icon. 
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2. In the export dialog box, the user can define the structural analysis behavior of each of the 

elements. This information will not be covered in this manual. 

 
 

3. Example model export in RM Bridge. 

 
4. RM Bridge assumptions and limitations can be found in Appendix D. This concludes the exporting to 

RM Bridge tutorial. 
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Interoperability with ProStructures 
OBM now includes a vast number of tools from ProStructures within the OBM application. When the user 

Activates ProStructures within OBM the DGN will be branded as a ProStructures file. It is recommended to 

create a new blank OBM DGN file and then reference the original DGN to perform all ProStructures tasks in 

the new file. 

Note: There are known compatibility issues with ProStructures files created in ProStructures and the ones 

created within the OBM ProStructures plug-in. Reinforcement created in one cannot be modified in the other 

program. 

This manual will not cover any of the ProStructures tools as they are very extensive, a new training manual 

just for ProStructures will be created and used for the detailing of Concrete and Steel bridges. 

ProConcrete tools are in the ProConcrete task. The user can reinforce beams, footings, walls, columns 

amongst other elements. This task also has limited tools to create and modify rebar definitions. 

 

 

Placement of rebar schedules is available in OBM when the ProStructures plug-in is activated. Another task 

becomes available labeled Structural Detailing. In this task, there is a Concrete Drawing Production Tab and 

a Numbering, Marking section with the rebar scheduling tools. 

 

This concludes the ProStructures interoperability section. 
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                               Appendix A – Plan Production Examples 
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The following sheets were created using the workflow/process shown in the Plan Production section. 

For the span sheet, a secondary clipped reference was added to show only the exterior beams, the reference 

was added manually, using the view created by the named boundaries. 

Typically in span sheets we do not show the crowned deck, but in OBM we either have the cross slope or we 

don’t, we cannot change the setting for the different types of drawings, so we have to adjust our standard 

drafting practices. 

The border is a reference that is linked to the drawing seed, the users can replace the reference file as long 

as they keep the name of the file and just replace the contents. 

All annotations were done manually. 

 

 

Example Span Sheet of Box Beams 
 

For the abutment sheets, details like the earwall detail and corner details were copied from the standards for 

simplicity. These drawings can also be done using OBM plan production tools. 

Some lines were drafted manually, and some edges were masked using a line the same color as the 

background. 

All annotations were done manually. 
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Example Abutment Sheet of Box Beams 
 

 

Example Abutment Sheet of Box Beams 
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LEAP Bridge Concrete (LBC)  

Please be aware of the following assumptions and limitations when transferring the physical 
model from OBM to an analytical model in LBC, and bringing changes back from LBC to OBM.  

1. Data Transfer: In version 10.12.01.xx, the data transfer is bi-directional, e.g. from OBM to LBC (for 

all supported bridge types), and back from LBC to OBM (for prestressed concrete girder bridges). 

While the entire model is transferred from OBM to LBC, on the way back only selected 

superstructure (beams and beamlayout) and all substructure information is transferred. In LBC, use 

the Tools > OBM Sync > Send to OBM option to write information back to OBM via an XML file. In 

OBM on the Utilities tab of the ribbon toolbar, select LBC > Update from Analytics to select the same 

transfer XML file, and start the process of updating the OBM model with LBC data changes if any. At 

this time, other than footing design reinforcement, any other design reinforcement, strands or 

tendon information will not be transferred back from LBC to OBM.  

2. Model: Model must be completed in OBM, with all super and substructure including bearings defined, 

before transferring to LBC.  

3. Deck Slab Thickness: For a bridge model with varying deck thickness in spans, or across the cross-

section in a single span, OBM will transfer the minimum thickness of the slab across all cross-

sections and all spans to LBC. The deck thickness is not transferred back from LBC to OBM.  

3a.  Multiple Decks: In the properties window, setting the Analytical Flag = true allows the deck to be 

transferred to LBC. Users should not mark approach slabs as analytical decks. A series of contiguous 

decks can also be transferred to LBC.  

4. Haunch Thickness: While OBM models a very accurate haunch considering the slope of the deck 

transversely, and varying haunch thickness filling the gap between the top of the beam and the 

bottom of the slab, the analytical model in LBC uses a constant haunch thickness. OBM will 

conservatively transfer the maximum thickness from among all beams in all spans to LBC. The 

haunch thickness is not transferred back from LBC to OBM.  

5. Beam Layout: LBC only supports prestressed beams spanning between supports. End blocks 

modeled in OBM with different sections will not be transferred to LBC. Beam Layout (including 

spacing of beams) changes in LBC can be transferred back to OBM. User will have an opportunity to 

view and accept or reject changes before coming back to OBM.  

6. Beam Cross-sections: While transferring a beam cross-section from the non-LEAP library, e.g. a custom 

section which are typically drawn using MS drawing tools from OBM to LBC, LBC will first search for a 

matching name through its existing beam library, and if not will attempt to automatically create a new beam 

library object by interpreting a shape as close to the MS drawing as possible. The user may need to verify 

and modify this library object with appropriate structural properties and strand templates before continuing 

the design in LBC. When data is sent from LBC to OBM, changes to the Beam cross-section, if any, are 

flagged, and the user will have the opportunity to view and accept or reject the changes.  
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7. Diaphragm: Diaphragm defined in OBM is transferred in terms of the locations and equivalent point loads on 

concrete beams in LBC.  

8. For CIP P/T Box Girder bridges and RC or P/T Slab bridges: OBM will transfer an interpreted cross-

section, by populating the parametric variables, by intelligently interpreting the appropriate point 

pairs from OBM template. A screen showing the OBM Template and the interpreted cross-section is 

presented to the user before the final transfer to LBC. In this screen the user can modify the points 

used for picking up the points from the OBM templates. Changes from LBC to OBM for this bridge 

type is currently not supported.  

9. Bearings: LBC can currently only handle rectangular shape bearings. Any other shape of bearing 

coming from OBM is converted to equivalent rectangular bearing during transfer. Grout pads on top 

of the bearings in OBM are not transferred to LBC, but the thickness at the center is added to the 

bearing seat thickness to compensate. Changes from LBC to OBM for bearings is currently not 

supported.  

10. Materials: Beam material properties are transferred from OBM to LBC, and back into OBM if changes 

are made in LEAP. A new entry is created in the OBM materials library if an exact match of the 

materials modified in LEAP is not found.  

11. Substructure:  

a. Pier Location offset is measured in OBM, along the SupportLine, whereas in LBC it is 

measured perpendicular to the alignment. The conversion is done automatically when data is 

transferred from OBM to LBC.  

b. Since LBC does not support inclined/sloped pier cap, when such a cap is transferred from 

OBM, it is treated as a straight/level cap and the bearing seats adjusted to fill in the gap 

under bearings/beams.  

c. Other than the Oval column shape from OBM, all other 'regular' column shapes are 

supported in LBC. The Oval shape column is converted to an equivalent rectangular shape 

with fillets. When transferring template based column cross-sections from OBM, columns 

come in with a cross-section represented by a bounding rectangle around the shape. 

Variable pier caps with parabolic or circular variations are approximated by linear variations  

d. User defined templates for footings and abutments are transferred as equivalent rectangles.  

e. For Abutments, to accommodate various agency practices, OBM allows users to set three 

different locations (front face of backwall, centerline of abutment cap, back of abutment) as 

the reference line for placing abutments. Since LBC only allows one reference line at center 

of abutment, OBM on data transfer will maintain the accurate lengths of the girders, and 

adjust the position of abutment for an additional offset distance. Wingwalls are not 

transferred from OBM to LBC at this time.  
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f. Integral substructures for Box Girder bridges and RC Slab bridges, with the integral cap 

taking the shape of the superstructure are currently not supported in OBM. These will need 

to be modeled in LBC, after initial model transfer from OBM.  

g. All geometry changes made to substructure in LBC can be brought back to OBM. The user 

will have the opportunity to view and accept or reject the changes when updating the model 

in OBM using the transfer XML format file.  

h. If you have modified the column length in LEAP and you want to update the column length 

in OBM, please be sure to have the footings elevation constraints unchecked in order to see 

the updated model.  

i. For Variable Columns, defined using Templates, transfer to LBC is not possible at this time. 

12. Barrier: OBM will transfer Barriers from OBM to LBC as equivalent loads, and will also transfer the 

barrier width and location. User should check these loads and dimensions in LBC as these could 

affect the design.  

13. File Name: When attempting to transfer data from OBM to LBC, user can provide a file name and 

path for the LBC data file. If such a file already exists, OBM will replace only the geometry and 

material data and retain all loads and other design parameter information.  

14. Camber and Deflection results: If prestressed concrete beams are designed (with strands) in LBC, 

the results can be transferred back to OBM. Using the Reports > Camber option, user can view the 

estimated beam elevation values at erection, and deck screed elevation reports.  

15. For offset (from alignment) bridges, OBM and LEAP Bridge support line stationing could be different 

due to differences in assumptions on layout in these two products. While the conversion is done on 

the fly and the bridge will be located geometrically accurate, future versions will address this issue. 

16. Steel Cross Frames for Concrete beams modeled in OpenBridge Modeler will be transferred to LEAP 

Bridge Concrete as loads.  
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LEAP Bridge Steel (LBS)  

Please be aware of the following assumptions and limitations when transferring the physical 
model from OBM to an analytical model in LEAP Bridge Steel and bringing selected changes back 
to OBM.  

1. Data Transfer: In version 10.12.01.xx, the data transfer is bi-directional, e.g. from OBM to LBS, and 

back from LBS to OBM, for selected changes in superstructure and substructure. While the entire 

model is transferred from OBM to LBS, on the way back only selected superstructure (beams and 

beam layout) and all substructure information is transferred. In LBS, use the OpenBridge Modeler > 

Save to OBM option to write information back to OBM via an XML file. In OBM on the Utilities tab of 

the ribbon toolbar, select LBS > Update from Analytics to select the same transfer XML file, and 

start the process of updating the OBM model with LBS data changes if any. You will be prompted 

with a dialog showing what information has changed, along with options to bring in select 

information into OBM. In this release, stiffeners, cross-frames, field splices and shear studs are 

written from OBM to LBS, but any changes made in LBS, cannot be sent back to OBM.  

2. Stiffeners and Cross Frames defined in OBM can now be transferred to LEAP Bridge Steel along with 

the all other bridge elements defined. At this time, the transfer is only one way from OBM to LBS. 

3. Model: Model must be completed in OBM, with all super and substructure including bearings defined, 

before transferring to LBS.  

4. Deck Slab Thickness: For a bridge model with varying deck thickness in spans, or across the cross-

section in a single span, OBM will transfer the minimum thickness of the slab across all cross-

sections and all spans to LBS. The deck thickness is not transferred back from LBS to OBM.  

5. Haunch Thickness: In both OBM and in LBS, haunch thickness is measured from the bottom of the 

top flange to bottom of deck. OBM will conservatively transfer the maximum thickness from among 

all beams in all spans to LBS.  

6. Beam Layout: To cover a wide variety of possible scenarios, LBS will always bring in beam paths 

from OBM as custom beam paths. While the user can modify these beam paths in LBS and send the 

information back to OBM, deleting and adding entirely new beam layouts and attempting to transfer 

this information back to OBM is not supported.  

7. Beam Cross-sections: When using Rolled Beam Shapes, OBM transfers the appropriate name to LBS, 

and a corresponding section is picked from the Standard Sections list in LBS. For Built-up shapes, all 

transfers are by plate dimensions, a much simpler transfer. Steel Tubs can be transferred from OBM 

to LBS, but not vice-versa. The rotations of these sections from OBM are not supported in LEAP 

Bridge Steel, and they will be modeled without the rotation following the deck slope.  

8. Bearings: LBS can currently only handle rectangular shape bearings. Any other shape of bearing 

coming from OBM is converted to equivalent rectangular bearing during transfer. Grout pads on top 

of the bearings in OBM are not transferred to LBS, but the thickness at the center is added to the 
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bearing seat thickness to compensate. For Steel Tub girders supported by a single bearing in OBM, 

LEAP will automatically create two bearings due to current limitations.  

9. Substructure:  

a. Pier Location offset is measured in OBM, along the SupportLine, whereas in LBS it is 

measured perpendicular to the alignment. The conversion is done automatically when data is 

transferred from OBM to LBS.  

b. Since LBS does not support inclined/sloped pier cap, when such a cap is transferred from 

OBM, it is treated as a straight/level cap and the bearing seats adjusted to fill in the gap 

under bearings/beams.  

c. For Abutments, to accommodate various agency practices, OBM allows users to set three 

different locations (front face of backwall, centerline of abutment cap, back of abutment) as 

the reference line for placing abutments. Since LBS only allows one reference line at center 

of abutment, OBM on data transfer will maintain the accurate lengths of the girders, and 

adjust the position of abutment for an additional offset distance.  

d. LBS can have round, rectangular and rectangular-variable column shapes. OBM supports the 

following additional shapes: rectangular-chamfered, rectangular-filleted, rectangular-beveled 

and oval. All are transferred from OBM as standard rectangular columns in LBS. When 

transferring template based column cross-sections from OBM, columns come in with a cross-

section represented by a bounding rectangle around the shape. Variable pier caps with 

parabolic or circular variations are approximated by linear variations.  

e. Integral substructures in LBS will not transfer to OBM in this release of OBM.  

f. LBS does not support Struts between columns or wingwalls. So transfer from/to OBM is not 

yet supported for these elements.  

g. If you have modified the column length in LEAP and you want to update the column length 

in OBM, please be sure to have the footings elevation constraints unchecked in order to see 

the updated model.  

h. For Variable Columns, defined using Templates, transfer to LBS is not possible at this time.  

i. User defined templates for footings and abutments are transferred as equivalent rectangles. 

10. Auxiliary/Barrier: In this release OpenBridge Modeler will transfer Barriers from OpenBridge Modeler 

to LEAP Bridge Steel as equivalent loads. User should verify and adjust these elements in LEAP 

Bridge Steel as needed.  

11. File Name: When attempting to transfer data from OBM to LBS, user can provide a file name and 

path for the LBS data file. If such a file already exists, OBM will replace only the geometry and 

material data and retain all loads and other design parameter information.  

12. For offset (from alignment) bridges, OBM and LBS support line stationing could be different due to 

differences in assumptions on layout in these two products. While the conversion is done 
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automatically and the bridge will be located geometrically accurate, future versions will address this 

issue.  

13. Field Splices and Shear Studs defined in OpenBridge Modeler can be transferred to LEAP Bridge 

Steel. At this time, the transfer is only one way from OpenBridge Modeler to LEAP Bridge Steel.  
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            Appendix D – RM Bridge Connect – Assumptions and Limitations 
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RM Bridge CONNECT  

Please be aware of the following limitations when transferring the physical model from OBM to 
RM Bridge CONNECT:  

1. Steel girder top cover plates: they are not supported on transfer to RM because it will generate 

cross section elements overlapping which invalidates the geometrical model in RM.  

2. Barriers: they are not transferred because they can be simulated on RM side as a load on the side of 

the bridge.  

3. The following elements modeled in OBM are currently not transferred to RM:  

a. wing walls  

b. approach slab  

c. pile rock sockets  

d. advanced variable columns  

e. steel girder haunch extensions  

4. Materials: if no material is assigned to a structural element, a default material will be added on 

transfer to RM.  

5. Support springs on multi-unit transfer: Bearing springs will not generate correctly in cases where both side of 

the common pier have girder slab bridges. These springs can be corrected in RM Modeler manually.  
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